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Feperal CoOMMUNICATIONS COMMISSION
(FCC) STATEMENT

This equipment has been tested and found to comply with the limits for
a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits
are designed to provide reasonable protection against harmful interfer-
ence in a residential installation. This equipment generates, uses and can
radiate radio frequency energy and, if not installed and used in accor-
dance with the instructions, may cause harmful interference to radio com-
munications. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be determined by
turning the equipment off and on, the user is encouraged to try to correct
the interference by one or more of the following measures:

e  Reorient or relocate the receiving antenna.

e Increase the separation between the equipment and receiver.

e  Connect the equipment into an outlet on a circuit different from
that to which the receiver is connected.

e  Consult the dealer or an experienced radio/TV technician for
help.

WARNING
Use only shielded cables to connect I/O devices to this equipment.

You are cautioned that changes or modifications not expressly approved
by the manufacturer for compliance with the above standards could void
your authority to operate the equipment.

FCC
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IMPORTANT SAFETY INSTRUCTIONS

The notebook computer is quite rugged, but it can be damaged.
To ensure that does not happen, follow these suggestions:

1. Don’t drop it. Make sure it’s on a stable surface. If the computer
falls, the case and other components could be damaged.

2.  Don't overheat it. Keep the computer and power supply away
from any kind of heating element. Keep the computer out of
direct sunlight.

3. Avoid interference. Keep the computer away from high capac-
ity transformers, electric motors, and other strong magnetic fields.
These can hinder proper performance and damage your data.

4. Keep it dry. This is an electrical appliance. If water or any other
liquid gets into it, the computer could be badly damaged.

5. Be careful with power. The computer has specific power re-
quirements.

* Only use a power adapter approved for use with this com-
puter.

* Your AC adapter may be designed for international travel but it
still requires a steady, uninterrupted power supply. If you are
unsure of your local power specifications, consult your dealer or
local power company.

* The power adapter may have either a 2-prong or a 3-prong
grounded plug. The third prong is an important safety feature;
do not defeat its purpose. If you do not have access to a compat-
ible outlet, have a qualified electrician install one.

* When you want to unplug the power cord, be sure to discon-
nect it by the plug head, not by its wire.

iv safety



* Make sure the socket and any extension cord(s) you use can
support the total current load of all the connected devices.

¢ Before cleaning the computer, make sure it is disconnected
from any external power supplies (i.e. AC adapter or car adapter).

BATTERY PRECAUTIONS

Only use batteries designed for this computer. The wrong bat-
tery type may explode, leak or damage the computer.
Recharge the batteries using the notebook’s system. Incorrect
recharging may make the battery explode.

Do not try to repair a battery pack. Refer any battery pack repair
or replacement to your dealer or qualified service personnel.
Keep children away from, and promptly dispose of a damaged
battery.

Always dispose of batteries carefully. Batteries may explode
or leak if exposed to fire, or improperly handled or discarded.

UL® Mainboard Battery Note

CAUTION: Danger of explosion if battery is incorrectly re-
placed. Replace only with the same or equivalent type
recommended by the manufacturer. Discard used bat-
tery according to the manufacturer’s instructions.

0

Warning

The product that you
have purchased con-
tains a rechargeable
battery. The battery is
recyclable. At the end of
its useful life, under
various state and local
laws, it may be illegal to
dispose of this battery
into the municipal waste
stream. Check with your
local solid waste officials
for details in your area
for recycling options or
proper disposal.

Your battery pack is la-

beled with the type and
manufacturer.

safety v
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CLEANING

Do not apply cleaner directly to the computer, use a soft clean
cloth.

Do not use volatile (petroleum distillates) or abrasive cleaners on
any part of the computer.

SERVICING

Do not attempt to service the computer yourself. Doing so
may violate your warranty and expose you and the computer to
electric shock. Refer all servicing to authorized service person-
nel.

Unplug the computer from the power supply. Then refer ser-
vicing to qualified service personnel under any of the following
conditions:

* When the power cord or AC/DC adapter is damaged or frayed.
e |If the computer has been exposed to rain or other liquids.

e If the computer does not work normally when you follow the
operating instructions.

e If the computer has been dropped or damaged.

vi maintenance



CONVENTIONS

This manual uses the following typesetting conventions:

commonly used terms (capitals):
features on the notebook (icons):

keyboard keys (bold, as printed):

programs, operating systems (italics):

files (all capitals):
program groups (bold):

sequences (arrows):

icons/user interface switches (bold):

menu items (initial capitals):
variables (quotes):

text the user must enter (bold):

keys to press while in DOS (brackets, bold):

command switches (bold):

space:

Example
FDD, HDD, AC, DC

©-

Y, N, Enter

Setup, Windows 95
AUTOEXEC.BAT
Control Panel

My Computer >
Control Panel

Continue, Yes
Boot High Speed
“Enabled”
a:>\setup
[Enter]

format /s

conventions
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. Introduction

This manual is an introduction to your notebook computer system, its main features, and how
to get it working.

In this chapter we cover:
e How to use this manual.
e A system map

* A Quick Start Guide for “advanced users”.




[Introduction]
USING THIS MANUAL

Depending on how your system is
configured, some or all of its features
may already be set up. If they aren’t,
or if you need to re-configure (or re-
install) portions of the system, refer to
this manual.

PAGEs
Each page of the book has three parts:
M Outer Margin This area is reserved for
. warnings (be on the look- %%
For Beginners outfora €7, special ,
If you are new to the notices or tips () Advanced Advice
wonders of notebook Main Section for introductory text and Advanced users should check the sidebars which
computers, or just feel s look like this.
lik P begi J . descriptions . You'll find setup information about drivers, tips
ke a beginner, you Inner Margin  for advanced explanations and mere deiailed infemation abeut ihe
should still look over all & procedures (watch for a notebook’s various features.
of the documentation. #) and software setup in- “Beginners” are welcome too. As you get used
Don’t worry if you don’t structions (watch for a +)) to your computer, you may be surprised at how

understand everything much of this stuff you can understand.

the first time around. Just
keep this manual near
your computer, and learn
as you go.

1-2 pages



CHAPTERS

Each chapter highlights one of the computer’s main sub-systems,
what it does, and how to get it working.

Preface

Chapter 2: System
Chapter 3: Media
Chapter 4: Firmware
Chapter 5: Power

Chapter 6: Extras

Appendicies A & B

Glossary

Not HERE

This has the usual legalities, table of contents,
and most importantly, safety instructions.

Has information about the keyboard, TouchPad,
video & audio systems, and PC Card (PCMCIA).
Looks at media storage devices: HDD, CD-ROM,
DVD-ROM and Floppy.

Is about the notebook’s built-in software: the
POST and Setup utilities.

Examines the power system, both hardware and
software, including power management options.
Is about improving the system with additional
RAM, utilities, some “non-essential” or “enhance-
ment” software, and the optional port replicator.
These have information and explanations of the
system’s specifications and troubleshooting tips.
Have definitions for terminology that may be new
to you.

Operating systems (i.e. Windows 9x, Windows NT 4.0 , OS/2 Wap,
UNIX, etc.) have their own manuals as do application software (e.g.
word processing and database programs). If you have questions
about those programs, you should consult those manuals.

chapters/non- manual

2
é
Warning
Pay careful attention to
warning and safety in-
formation indicated by
the “& ” symbol and in

the Preface.

Improper usage or main-
tenance of the the com-
puter and/or its power
system could damage
the system and/or data
as well as void your
warrantee.




Introduction
SYSTEM MAp

The following graphics are a general map of the notebook com-
puter. Explanations of the various subsystems are covered in the
chapters indicated.

FroNT View: LCD, Work PANEL & ToucHPAD

WoRk PANEL VIEW
Fic. T - 1A

microphone
speakers
close-cover switch
power button
status screen
keyboard
TouchPad & buttons

NOY U W=

1-4 front view



Latch To open the notebook cover, slide this latch to the right.
TouchPad Chapter 2: System covers basic functions.

Chapter 6: Extras, has a supplemental driver.
LCD Video functions are covered in Chapter 2: System.

Work PANEL VIEW
Fic.1-1B

microphone
speakers
close-cover switch
power button
status screen
keyboard
TouchPad & buttons

NOoO Ul kW=

2ND ID

front view 1-5
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LErT PANEL

Fic. 1 -2
1. CD-ROM Bay
2. Power Bay

1-6 left view

Lert ViEw: CD-ROM? BAy, AND POWER BAy

CD-ROM Chapter 3: Media covers basic functions,
Chapter 6: Extras, has additional audio utilities.
Power Bay Refer to Chapter 5: Power and Appendix A: Specifi-

cations for all aspects of the power system.

t or DVD-ROM (optional factory installed modules)




RiGHT View: DRrives, Aubio & PC CARD

HDD Bay

FDD

L

A2 O ©-

Kensington Lock

Refer to Chapter 3: Media for more on how to setup or
replace a HDD.

Chapter 3: Media, covers the options available for
this bay.

(Fax-Modem) For more on this option, refer to Chap-
ter 2: System. If your system doesn’t have a fax-mo-
dem installed, this slot will have a cover. Do not re-
move it. Ask your dealer about installing a fax-mo-
dem module.

(PC Card) Your computer uses newer technologies than
the drivers included in Windows 95. Use the setup

procedure detailed in Chapter 2: System. Supplemen-
tal PC Card drivers are detailed in Chapter 6: Extras,
“Card Wizard"”.

(Audio) Setup for these ports is covered in Chapter 2:

System.
This is a standard security port.

AN

&
Warning
Don’t block the fan. Over-

heating may cause system
instablility.

RIGHT PANEL
Fic. 1 -3
1. HDD Bay
2. Floppy
3. Floppy eject button
4. fax-modem (option)
5. PC Card slots
6. mic-in
7. phones - using this port
disables the speakers.
8. audio line-in
9. system cooling fan
10. adapter port
11. Kensington lock port

right view 1-7
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REAR PANEL (COVER CLOSED)
Fic. 1 -4
1. expansion port (open)
2. serial 2 IrDA port

1-8 rear view

ReArR ViEw: PORTs

The principal peripherals plug in on this panel. To be safe, turn off
both the system and peripherals before connecting them. Turn the
peripherals on first, before you turn on the system.

% [Expansion Port] With the main hinged door closed, connect to
this port through the sliding door. The optional port replicator is
covered in Chapter 6: Extras.

ItDA  This port uses (serial) COM2 resources. The infrared connection

supports the SIR, FIR and ASK standards. Its most common use
is for a printer, modem or LAN.
Note: Newer versions of Windows 95 have an IrDA driver built
-in For older versions, support is available from Microsoft Corp.
For other operating systems and IrDA standards, consult your
system vendor. Also consult the user’s guides for the device this
port is going to work with.
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PS/2 Note

You can only use one type of PS/2 de-
vice per system session. If you want to
use a different device (mouse or key-
board), you must shut down and restart
the system. However, you can detach
and reconnect the same device during
a system session.

= © o=—=10
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[PS/2 Port] Use this with any stan-
dard PS/2 external keyboard or
mouse. For details, refer to Chap-
ter 2: System, “TouchPad”.

(USB) Refer to Chapter 2: System
on how to activate this port.

[TV-out] Jack This is explained in
Chapter 2: System.

[COMT1 (serial)] Use this with any
9-pin serial device (e.g. a mouse,
serial printer or modem). Consult
the user’s guides for the device
this port is going to work with. For
pointing devices, refer to Chap-
ter 2: System, “TouchPad”.

PN AW

N1/

Warning

The default settings in
Setup make all ports
“hot”. Depending on the
peripheral, this could
cause a problem when
you attach it. Check your
peripheral’s manual be-
fore you make a connec-
tion.

REAR PANEL (COVER OPEN)
Fic. 1 -5

PS/2 port
USB port
TV-out
COMT1 serial port
external monitor port
LPT1 parallel port

rear view 1-9
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rear view

(]

[External Monitor] Use this port
with any standard color VGA
monitor. For details, refer to Chap-
ter 2: System.

[Parallel Port] This port supports
several standards:

*Output only (Standard AT)
eBidirectional

eEnhanced (EPP)-versions 1.7 & 1.9
eExtended Capabilities ECP
Most printers use the Standard
mode. The Setup’s Help bar (re-
fer to Chapter 4: Firmware) ex-
plains how to adjust this setting.
Your peripheral’s manual explains
how to configure the device.
This port also serves as the exter-
nal FDD connection. Refer to
Chapter 3: Media for more on this
feature.

Your operating system may include driv-
ers for many printer models. Consult your
printer dealer for the most recent driver
for your model, as this can greatly affect
the performance of the printer.
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Borrom ViEw: COMPARTMENTS
The Drive bay is covered in Chapter 3: Media. v
‘ 7~

Warning
Don’t block the cooling
vents. Overheating may
cause system instablility.

¢
Warning
Follow the safety in-

structions for using bat-
teries.

Bottom PANEL
Fic. 1 -6
1. system cooling vents
2. RAM compartment
3. Battery compartment

bottom view 1-11
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Key Combinations
Whenever you use a key
combination, start press-
ing them in the order they
are listed. Don't release
any of the keys in a se-
quence until you’ve
pressed the last one.

Table 1T -1
Hot Key CONTROLS

1-12 hot keys

Hot Key CoNTROLS

Some of the features are managed by Fn+key combinations:

Indicator Meaning Effect

En + éa freeze actiyates "Save to Disk" ‘if the %ave to Dlisk partitionffile is
available, otherwise activates "Suspend" (to RAM)

F2 enter Setup If pressed immediately after boot-up, this starts the Setup utility

Fn+ 5 Standby/Suspend activates "Suspend" (to RAM)

Fs LeDIMontor | e Gefer o vidoo seup formation)

Fn + @ Speakers On/Off toggles the on-board speakers on/off (does not affect phones)

Fn + (])))) volume up increases audio volume

Fn + l:])))) volume down reduces audio volume

Fn + X4 brightness up increases LCD brightness

Fn+ X} brightness down reduces LCD birghtness

Fn+ ¢ contrast up increases LCD image contrast (DSTN display only)

Fn+ @ contrast down reduces LCD image contrast (DSTN display only)

(any key) resume izgiszc\)/\;ve:(r) sSIvsll?ug modes, including "Suspend" (to RAM), but




STATUS SCREEN INDICATORS

Your notebook lets you know what it’s doing with the following
status screen indicators:

Indicator Meaning Effect
ﬁ Embedded numeric keyboard is on. Pressing the
NumLock .
affected keys produces numeric characters.
() CapsLock is on. Pressing alphabetic keys produces
CapsLock capitalized characters - other keys are unaffected.
Table 1 -2
ﬁ Scroll Lock Scroll Lock is on. STATUS SCREEN INDICATORS
i HDD bay HDD is being accessed.
B Floppy Floppy is being accessed.
i PC Card PC Card socket(s) are in use.
@ Drive bay CD-ROM/DVD-ROM is being accessed.

icons 1-13
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Table 1 = 2 (cont.)
STATUS SCREEN INDICATORS

icons

1-14

Indicator Meaning Effect
- Full power All subsystems are fully powered.
I
e Sleep mode The CPU clock is on "hold", all subsystems are in
1 a reduced-power mode, and the LCD is off.
Suspend to RAM The CPU and other chips are turned OFF, RAM
& is refreshed slowly, system fan is OFF, peripheral
devices and ports are in power-saving mode.
Battery > 80% Battery has more than 80% power, considered "Full".
[y ~ [l | Battery < 80% to 20%
Battery < 20% "Low" battery range, rechare with the adapter
I y y rang P
[ Battery empty
1~ [ charging Steady lines correspond to charge level, cycling

lines & frame blink

lines indicate "dumb" battery charging.

all lines & frame blink

system problem

Re-insert or replace the battery, if the problem
continues, consult your service representative.
Do Not Attempt to Repair the Battery.

v

AC-in

System is receiving AC power.

PAckING CONTENTS
Keep the packing materials in a safe place in case you need
them for shipping or long-term storage.




QuICK START

If you're already familiar with notebook computers, the steps
listed below tell you how to start up the notebook for the first
time. They assume that you know where all of the parts of the
computer are. You should review these steps, before you take
any action. If you aren’t sure about one of the procedures, check
the relevant chapter before continuing.

1.

Follow the safety instructions on page iv, especially the instructions
on placement.

2. Remove all packing materials, floppy disks and any PC Cards.

3. Secure the battery pack in its compartment. (Ch. 5)

4. Securely attach any peripherals you want to use with the notebook

© S N @

(i.e. mouse or keyboard) to their ports. (Ch. 1)

Attach the AC adapter to the port on the side of the computer. (Ch.5)
Plug the AC power cord into an outlet.

Connect the AC power cord to the AC adapter.

Raise the lid/LCD to a 90° angle.

Push in the (D button (power switch) to turn “on”.

AN

M

Battery Charges
When you get your system,
the battery(ies) may not be
fully charged. Follow the pro-
cedure in Chapter 5: Power,
First Time Use and Storage
(page 5-4), to charge it.

M

Save To Disk

If you plan to use the Sus-
pend to Disk partition option
in the future, setup the parti-
tion before you install the
operating system. This in-
volves creating partitions and
formating your hard disk. Re-
fer to Chapter 5: Power and
your operating system docu-
mentation for details.

quick start 1-15
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. System

This chapter is about how to use and setup the most visible parts of the system:

input: e the keyboard
the TouchPad

Output: e Video subsystem
¢ Audio subsystem
Communications e PC Card

Fax/modem
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Other Systems

Some operating systems
lack supporting software
for some components.
If the software you need
is not included on our
CD-ROM, contact your
dealer or service repre-
sentative.

2-2 procedures

SeTuP PROCEDURES

This chapter describes the basic setup for the Windows 95/98
and Windows NT 4.0 (with Service Pack 3) operating systems.
These procedures are described in the inner margins and indi-
cated by a “[5".

If you're using DOS system, check the appropriate “README”
files on the accompanying CD-ROM. For other operating systems

(e.g. OS/Warp, Windows 3.1x, UNIX, etc), please consult the
manuals for those operating systems.

For additionial, nonessential, utilities check out Chapter 6: Extras.



B

Special Characters
Some software applications allow the number-
keys to be used in conjunction with Alt to pro-
duce special characters. These special char-
acters can only be produced by using number
keys on the embedded numeric keypad. Regu-
lar number keys won’t work.

KEYBOARDS

The notebook keyboard is like a full-
sized version with typewriter-like keys
and function keys. But, since it’s a note-
book, it also has special function keys
(listed on page 1-12) .

Fil © F12 puse  Prsc
ot o) | Break sy

Function Keys
Many software packages
make use of Function
keys (F1 ~ F12), so you
should consult those
manuals.

Type Kevs

Fic. 2 -1
The embedded numeric key-
pad (outlined) is activated
by pressing NumLock - its
LCD will appear)

FuncTioN KEys
Fic.2 -2

keyboards 2-3
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PS/2 KeyBOARD PORT

2-4

Fic.2-3

keyboards

ExXTERNAL KEYBOARDS

You can attach an external keyboard to the & (PS/2) port. If you
don’t have a 6-pin keyboard connector, use a 5-to-6 pin adapter
cable. The system automatically detects and enables the external
keyboard as well as the notebook’s. However, for those func-
tions requiring the Fn key, use the Ctrl + Alt key combination.

If you have a Y-connector, you can attach both a keyboard and
PS/2 mouse. However whatever the arrangement, the port can
only accept one type of device configuration per system session.
For example, if you connect a PS/2 mouse to this port, you
cannot connect a keyboard to the port during the same system
session. Doing so will cause a system conflict. If you already
have a mouse attached, and want to use a keyboard, you must
shut down and restart the system. However, you can detach and
reconnect the same device during a system session.
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Configuring the TouchPad
The TouchPad uses the PS/2 port which is fac-
tory enabled. It can use the “Microsoft, or IBM
PS/2” mouse driver available with most operat-
ing systems. Optimized TouchPad software for
various operating systems is on the Software &
Utilites CD-ROM which came with the system
and is covered in Chapter 6: Extras.

£

Using TouchPad & Serial Device
Winbows 95/98
1. Attach the serial device when the system is off.

2. Turn on the system and allow Windows 9x
to detect and configure the device on the
serial port (COMT). Insert the
manufacturer’s driver disk(s) if required.

3. Both devices are enabled.

To switch back to the TouchPad exclusively:

1. Exit Windows 9x.

2. Detach the serial device.

3. Start Windows 9x. It will automatically en-
able the available pointing device, in this
case the TouchPad.

For information on how to change mouse set-

tings for other operating systems, consult the
manuals for those operating systems.

ToucHPAD

The system automatically enables the
built-in TouchPad. If you're using any
version of Windows, you don’t have to
install a driver for it. However, you must
install a driver (if your dealer hasn’t al-
ready done this for you) for the DOS
environment.

If you want to use the TouchPad’s ad-
vanced features, refer to the driver in-
formation in Chapter 6: Extras.

THe ToucHPAD
Fic.2 -4

1. sensor pad
2. left “mouse” button
3. right “mouse” button
Note for left-handers: most
operating systems allow you
to reverse the mouse-button
settings.

TouchPad 2-5
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TouchPad

ToucHPAD & SeriAL DEevice

If you want to use a serial device as
well as the TouchPad, you must make
sure the device’s driver can “see” it on
COML. In some operating systems, you
can only use one pointing device driver
at a time, either serial or PS/2. To use a
serial device, attach it to the port
(while the system is OFF) and then start
up and configure it with a suitable driver.

ToucHPAD & PS/2 Device

If you haven’t installed any specialized
pointer drivers, you can also use a
mouse connected to the PS/2 port. Just
make the connection, and the system
automatically detects an attached
mouse, enabling it as well as the
TouchPad using the same drivers.

Note:  the PS/2 port only accepts one type
of device per system session. If you
want to switch to another device,
you must shut down and restart the
system. However, you can detach
and reconnect the same device dur-

ing a system session.

%

Using TouchPad & Serial Device

(cont.)

Winpbows NT 4.0

To use a serial device and the TouchPad at the
same time in the Windows NT 4.0 environment,
you must configure the operating system as you
install it the first time.

1.

Attach the serial device when the system is
off.

As Windows NT 4.0 runs its installation pro-
gram, it will ask you to confirm its hard-
ware and software components. At this
point, modify the list so that the pointing
device is: “Logitech Serial Mouse”.

The on-board PS/2 mouse will still be auto-
matically enabled and if you install one,
the resources will be available for a serial
mouse.

If you want to use serial mouse on COM1,
make sure it is present when you boot-up,
and both devices will be active.
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Video Setup

Winbows 95/98

To setup the Windows 9x video driver and utilities:

1.

Refer to page 2-19 to enable the USB feature
(for Windows 95 only ).

Insert the Software & Ultilities CD-ROM, then
Select Run from Start menu and navigate to

d:\drivers\win95\agp\ALiAgp15.exe*
or d:\drivers\win98\agp\ALiAgp15.exe*
*This assumes your CD-ROM is in drive “D:”.

Open this file to launch the setup. When
prompted, allow the system to restart.

Select Run from Start menu again and navi-
gate to d:\drivers\win95\video\setup.exe

or d:\drivers\win98\video\setup.exe

Follow the on-screen instructions to install the
ATI driver. When prompted, click on Yes to
reboot the system.

After reboot, the “ATI Desk Top Help” ap-
pears. Uncheck Show this screen next
time you start Windows, if you don’t want
to see this help screen on next boot.

Open Control Panel > Display, then click on
Settings > Advanced Properties or Ad-
vanced...> Monitor (tab).

Click Change...(button) and choose a
“Laptop Display Panel” (any size). Click on
OK then on Close(twice). When prompted,
click on Yes to restart the system.

VIDEO

There are three display options: the
notebook’s LCD, an external monitor
(CRT) and TV. You can select between
them with the Fn+&] toggle or the
controls embedded in the video driver
interface. The interface also lets you
change the screen resolution and color
output to whatever is most comfort-
able/efficient for you.

As you examine the video driver (see
the side-bars for setup information), you'll
notice that some displays have more flex-
ibility than others. This is a matter of hard-
ware, video memory and the driver for
your operating system. The driver inter-
face shows the available options.

Gl

More on Video Displays
Appendix A: Specifications
has a chart of the system’s
display capabilities.

THe LCD ConNTRrOLS

Fic. 2 -5
Contrast controls

(not active with TFT)
Brightness controls

Display toggle
(LCD/CRT/TV)

video

2-7




[System]

Warning
Do not allow any for-
eign objects (i.e. paper
or plastic) to get be-
tween the lid/LC D and
the work panel. They
could damage or
scratch the LCD and/or
accidentally activate
the close-cover switch.

2-8 video-LCD

LCD

As you open the lid, adjust it so you
can look at the screen straight-on, with-
out any glare. If necessary, adjust the
brightness and contrast controls.

Note: If your model has a TFT screen, the

contrast controls aren’t necessary.

SETUP

The video drivers on the accompanying
Software & Utilities CD-ROM are opti-
mized for specific operating systems. If
the driver for your operating system isn’t
included, or you suspect it's outdated,
consult your dealer. These drivers are re-
quired if you want to use a TV display or
want enhanced performance on an exter-
nal monitor as well as the LCD.

The instructions in the side-bars tell you
how to install the drivers. However,
your operating system’s documentation
may have additional tips.

Note: For most operating systems, video
driver installation is different from

any other driver’s (i.e. sound).

&)

Video Setup (cont.)

Winbows NT4.0
To setup the Windows NT video driver and utili-

ties,
1.

Install Windows NT 4.0 Service Pack 3 (SP3)
or above if you haven’t done so.

Open Control Panel > Display.

Click on Settings > Display Type... >
Change... (button) in the vga compatible
display adapter field.

Insert the Software & Utilities CD-ROM.
Select Have Disk....

Click on Browse... and navigate to
D:\drivers\nt40\video\atirage.inf*
Click on Open and then on OK.

* This assumes the video driver is on a CD-ROM identified
as drive “D:".

Select “ATI 3D Rage LT Pro AGP 2X” and
click on OK and/or Yes to continue the
installation.

When finished, close the various screens
and reboot. When you restart and return to
the Display page, you can change the set-
tings to your preferences. When finished,
you must Apply the new settings to take
effect.

Note: This driver doesn’t support TV output.
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Video Setup (cont.)
The Rage LT Pro driver adds three additional pages
to the “Advanced” button in “Setting” tab of Dis-
play Properties* to support the new enhanced dis-
play features. The new added pages allow you to
select output devices (Display page), to adjust the
position and size of your screen (Adjustment page),
as well as to correct color tone differences be-
tween real color values and the way your monitor
or flat panel displays them (Color page).
Note: For Windows 95, the Display option is embed-
ded in Setting page (see example on next page). It also
adds an additional Panning page to Display Properties
for setting hotkeys to control panning when the desktop’s
display area is larger than the screen resolution.

Properties [7]x]

Genersl | Adspter | Monter | Pefomance |
Colorenagement | 3 Displays | P20 Adusmere | P Color

[¥ ianito? I~ Televisior ¥ LED Panel

Opt

I Conter dislog boses

¥ Enale task bat ioon

ok | ceea || s | e

* For Windows 95/98 only

EXTERNAL MONITOR

If you prefer to use an external moni-
tor, connect it to the VGA port on the
rear panel.

Note:

To reduce flickering on an exter-
nal monitor, use faster refresh
rates. But first check vyour
monitor’s documentation to make
sure it can support the rates listed
by the video driver.

DispLAY PROPERTIES
CoNTRrROL PANEL

Fic.2 -6
VGA Port
Fic.2 -7

Make sure both the external
monitor & notebook are OFF
before you connect them.

video-CRT 2-9
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Warning
The NTSC and PAL set-
tings can only be used
with the appropriate
televisions.

TV Port
Fic.2-8
Both the TV & notebook
should be OFF before you
connect them.

DispLAay PANEL TV SETTINGS
Fic.2-9
Be sure the NTSC/PAL setting
on the Device page is correct.

2-10 video-TV

v

To use a TV display, conect the Y-cable
TV-adapter’s mini-din plug connects
to a video adapter cable. However,
before you use this connector, make
sure the driver is configured for your
TV’s standard: NTSC or PAL (use the
video driver control panel).

£y

Alternative TV Output

By default, your computer is configured for “S”
type video output. If your configuration requires
the earlier, “AV” output, or your TV output color
is incorrect, be sure to have your dealer to reset
the SW2 jumper. Do not try to change the
jumper settings yourself. Doing so may damage
your system as well as void your warrantee.

Note: Windows NT4.0 doesn’t support TV out-
put. For Windows 9x, use the Display control
panel to switch between each display device.

Displap Praperties HE
Backgound ScieenSaver | Appesance |
FaD Adjustment | Y2l Fanning | E2d Color Setlings

- Moo v Teleyjsion I~ LD Panel
Sae fs Delete |

—Eulm B D5

T | Sogeen: 1024470

_-— | | Hor
[ Eont sfze Diesktop: T02447E0

Smal Forts - Schems Hotkey

Mormal size (36 cpi { [Hone

¥ Center dialog boxes

R Encble task baricon Advanced Properties
I™ Show settings ican on task bar
0K | Ceneel | apb | Hep |




SWITCHING

You can switch between the notebook’s LCD and monitor (CRT)
by toggling Fn+&|. TV output is available only by using the
video driver control panel:

v Monitor Toggle Sequence Comment
Standard | Resolution 88 q
VGA
640 x 480
SVGA LCD > monitor > TV* TV output is supported in any
> LCD + monitor color depth supported by CRT
NTSC 800 x 600 (monitor) without panning.
XGA TABLE 2 — 1
1024x768 Vipeo Output
SXOA O : Key COMBINATION SEQUENCE
> monitor > .
1280x1024 LCD + monitor TV outputis not supported.
VGA
640 x 480
P TV output is supported in an
SVGA LCD > monitor > TV* p PP Y
800 x 600 > LCD + monitor color depth supported by CRT
PAL onito (monitor) without panning.
XGA
1024x768
SXGA LCD > monitor > .
1280x1024 LCD + monitor TV outputs not supported.

*Fn+F4 hot-key combination does not support TV output. To switch to TV display,
you must use the video driver control panel (i.e. Display Properties). For more
details, refer to page 2-10.

video 2-11
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Warning
To protect your hearing,
turn down the volume
before you plug-in ei-
ther headphones or
speakers.

AupIO SuBsYSTEM PORTs
Fic.2-10
. microphone
(disables internal microphone)
. headphones
/external speakers
(disables on-board speakers)
. line-in
. volume up control
. volume down control

2-12 audio

AUDIO

The audio subsystem, in combination
with the CD-ROM module, gives the
notebook multimedia capabilities. To
use it, You first have to install the cor-
rect drivers. These are included in the
software package which comes with
the system. The procedure is ex-
plained in the side-bar.

The controls and ports are on the func-
tion keys and on the left panel:

) L1)))] ot

=)

Audio Setup

Winbows 95/98

Your Windows 9x Setup utility cannot detect
the latest version of the ESS AudioDrive utility.
The utility included with your notebook takes
advantage of technical improvements since
Windows 9x’s release. To install,

1.

For Windows 95, disable “Plug & Play O/S”
(i.e. set to No) in BIOS setup (see page 4-8).

Open Control Panel > System > Device
Manager.

Click on Other devices, and remove PCI
Multimedia Audio Device.

Click on Refresh. When Add New Hard-
ware or Update Device Driver Wizard
appears, insert the Software & Ultilities CD-
ROM, and click on Next .

(If Windows 98, you need to choose “Search
for the best driver for your device”, then Next.)

Choose “Specify a location” (If Windows 98),

Click on Other Locations... (if Windows 95),
and browse to:

D:\drivers\win98\audio* ( if Windows 98)
D:\drivers\win95\audio* (if Windows 95)

Follow the on-screen instructions. When
the Wizard reappears, click on Finish to
complete the installation. If it asks for “In-
sert Disk”, redirect to the same location as
specified in step 4.

When finished, close the System Properties
panel. The audio drive is ready for your use.
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Audio Setup (cont.)

Winbows NT4.0

To install the audio driver after you’re into the
system, insert the Software & Utilities CD-ROM.
Then,

1.

Disable “Plug & Play O/S” (i.e. set to No) in
BIOS setup (see page 4-8).

Install Windows NT4.0 Service Pack 3
(SP3) or above if you haven’t done so.

Open Control Panel >Multimedia >Devices
(tab) and click on the Add button.

Double-click on “Unlisted or Updated
Driver” from the list. Then click Browse...
and navigate to: D:\drivers\nt40\audio*.

* This assumes your CD-ROM is drive “D:".

Click on OK (twice). When ESS Maestro
PCI Driver 4.02.13 appears, click on OK
(twice) to confirm the resource settings.
When asked, restart the system to activate
the driver.

After the system restarts, you will see a speaker
icon in the task bar on the lower right corner.
You may double-click on the speaker icon to
open the sound control panel to adjust the set-
tings to your preferences.

ADDITIONAL AUDIO

The Software & Utilities CD-ROM ac-
companied with your system also in-
cludes supplemental audio software
for Windows 9x. Refer to Chapter 6:
Extras for more details.

audio
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PC CARDs

The notebook has two PC Card expansion sockets:
socket 0 (lower), is Type III
socket 1 (upper), is Type II
Both sockets are backward -compatible. For example, a Type
IIT socket can handle a Type I, II, or III card.

Both support PCMCIA (rev. 2) and CardBus (PCI bus to PCMCIA
socket).

Both sockets are Zoomed Video (ZV). The ZV Port is a direct
connection between the PC Card and the notebook’s video and
audio subsystems. As such, it works directly with the CD-ROM
module to support multimedia features.

Refer to the documentation which comes with your ZV card for
more information about its capabilities and how to use its features.

PC CArD SOCKETS
Fic. 2 -11
1. Socket 0 (lower)
eject button
2. Socket 1 (upper)
eject button

2-14 PC Card
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PC Card Setup

Winbows 95/98

1.

2.

Download TI-1251B driver from the
Microsoft web site or talk to your dealer.

Copy the PCMCIA.INF to Windows\inf
folder (replacing the existing file).

(For WINDOWS 98, sKiP TO STEP 6 ONLY)

3.

4.

Delete *.bin (i.e. Drvidx.bin and
Drvdata.bin) files in Windows\inf folder

Copy CBSS.VXD, and PCCARD.VXD to
Windows\System (replacing the existing files).

Open Control Panel > System > Device
Manager (tab) > Other devices. Remove
the PCI CardBus Bridgelistings (there are 2)

Under PCMCIA socket, remove PCIC or
compatible PCMCIA controller or Generic
CardBus Controller listings (there are 2),
then click on Refresh.

Follow the on-screen instructions. If it asks
about keeping an exiting file, say Yes. If asked
for reboot, say Yes. For Windows 98, the sock-
ets will be ready for your use after reboot.
For Windows 95, continue to next steps.

Return to System Properties > Device
Manager. Double-click “Texas Instruments
PCI-1251B CardBus Controller” (there are
2) under PCMCIA socket and uncheck Dis-
able in this hardware profile. Follow the
on-screen instructions. When it asks for
reboot, say No for the first time.

After uncheck both controllers, reboot the sys-
tem and disable the “Plug & Play O/S” (i.e. set
to No) in BIOS setup (see page 4-8). After
reboot, the sockets are ready for your use.

OPERATING SYSTEMS

WiINDOWS 9x

The PC Card components are newer
than the drivers supplied by Windows
95/98, so before you can use this de-
vice, you must make some changes
(described in the side-bar) to your sys-
tem. Once you activate the PC Cards,
they are always “hot”.

The updated drivers are also PCMCIA
(rev. 2) , and CardBus compliant and
they recognize Plug 'n Play PC Cards.
However some older, “legacy”, cards
may require their own drivers. Al-
though you can hot swap any PC Card,
the accompanying utility provides en-
hanced resource support (see Chapter
6: Extra, page 6-8).

SRAM/FLASH Card

Note for Windows 98

SRAM CarD

1. Perform setup as de-
scribed in the side bar.

2. Modify the Config.sys file
in the root directory of
drive “C:" as detailed be-
low:

device=c:\wind\ yst pper.sys

device=c:\windows\system\carddrv.exe /slot=2

3. Reboot the system for the
changes to take effect.

FLASH CarD

1. Perform setup as de-
scribed in the side bar.

2. Insert your Windows 98
CD-ROM and locate
TRUFFS.INF file, then
click right mouse button
and choose install to pro-
ceed.

3. When finished, reboot the
system for the changes to
take effect.

PC Card 2-15
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Warning
Do not add, remove or
change cards while the
system is in a power sav-
ing mode. This may cause
a conflict with the stored
system configuration in-

formation.

Warning

Some operating systems
may experience difficul-
ties if an I/O card (e.g. a
fax/modem) is present in
the socket when you
warm boot the notebook.
Depending on your op-
erating system, the COM
ports (I/O) for PC Card
devices are reassigned.
Note: Windows 95 &
Windows 98 does not
have this limitation.

2-16 PC Card

Winpows NT 4.0

The operating system automatically installs the PC Card socket
drivers. This driver is only PCMCIA (rev. 2) compliant. You can
install or remove cards only when the system is turned off. In
particular, any I/O PC Card (e.g. LAN or SCSD must be present when
you boot-up the system. CardBus and ZV support are not available.

The optional SystemSoft Driver allows hot insertion and hot re-
moval, and provides CardBus support (see Chapter 6: Extras).

INSERTING A PC CARD

PC Cards require drivers specific to your operating system: one for
the computer’s sockets (see above), and a driver for the card
you’re installing. The first time you install a PC Card, Windows 9x
and NT 4.0 prompt you for that card’s driver. If your operating
system supports Plug n’ Play (e.g. Windows 98), PC Cards can be
inserted and removed while the system is on.

When the card is in correctly, the system beeps once. If the PC
Card is not detected, check if the correct drivers are loaded.

RemovING A PC CARD

Push the appropriate eject button to remove the card. The sys-
tem will beep twice when the card is ejected.
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Setting up the Fax/Modem

Winbows 95/98
When Windows 9x starts up, it detects the Fax/
Modem and launches the Update Device
Driver Wizard.

1.

Insert the Software & Utilities CD-ROM.
Click on Next.

For Windows 98, choose “Search for the
best driver for your device”, then click on
Next > Browse and navigate to

d:\drivers\win98\modem*
*This assumes your CD-ROM is drive “D:".

For Windows 95, click on Other Locations
> Browse, and direct the wizard to
d:\drivers\Win95\Modem*

*This assumes your CD-ROM is in drive “D:".

Follow the program’s dialog boxes. When
the Wizard reappears, and/or if it asks for
“LT Installation Disk”, redirect the wizard
to the same location as specified in step 2.
Follow the on-screen instructions to com-
plete the setup.

When the installation is complete, Windows
returns to its standard view. For Windows
95, reboot the system and press F2 during
the POST. Then diable the “Plug & Play O/
S” (i.e. set to NO) under Advanced Menu.

Click the Modem icon in the Control Panel
to continue the OS’s setup (the LT Win Mo-
dem should be assigned to COM3).

F AX/ MODEM (OPTIONAL MODULE)

If your system includes the fax/mo-
dem module, both Windows 95 and
Windows NT 4.0 will detect it during
setup. However, our module takes ad-
vantage of newer technologies so you
will have to install our updated drives
to take advantage of its full speed.

Fax/MODEM PORT

Fic.2-12

Fax/Modem
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Fax/Modem

USAGE

Once your fax/modem is setup, you
still have to configure the software that
will use it. For the most part, this means
working with your operating system’s
“Network” settings.

Be sure to keep the original installa-
tion software handy as you do this.

Additional information about how to use
the fax/modem (e.g. AT commands) is
included with the driver on the Inter-
nal Fax/Modem Drivers floppy.

INTERNET ACCESS

For Dial-up Internet access, you must
be sure to have all the proper “proto-
cols” installed (e.g. TCP/IP). Refer to
your operating system manual for this
and/or your Internet Service Provider’s
documentation.

)

Setting up the Fax/Modem (cont.)
Winobows NT 4.0

I

Disable the “Plug & Play O/S” (i.e. set to
No) and Serial Port B in the BIOS setup
(see Chapter 4: Firmware).

Install Windows NT4.0 Service Pack 3 or
above if you haven’t done so.

Open Run from Start menu, then click on
Browse and navigate to
d:\drivers\nt40\modem\setup.exe*
*This assume your CD-ROM is drive “D:".
Follow the on-screen instructions. When
prompted, allow the system to restart.

When the system restarts, click Modems
icon in the Control Panel (the modem should
be assigned to COM2). Then click on Dial-
ing Properties to continue the setup.



USB Setup

Winbows 95
Follow steps below to enable the USB feature,

1.

Disable “Plug & Play O/S” (i.e. set to No)
in BIOS setup (see page 4-8).

Obtain the “usbsupp.exe” utitlity. This may
be included on the CD-ROM containing
Windows 95 (OSR2.1 version or above) or
download the utitlily from Microsoft’s web
site (if you have difficulty finding it, ask
your dealer for help).

Open Control Panel > System > Device
Manager (tab) > Other devices. Remove
the PCI Universal Serial Bus listing. Then
click on Close.

Using the Windows Explorer, double-click on
“usbsupp.exe” to launch it. Follow the
program’s dialog boxes to install the USB
Supplement to your system. When prompted,
allow the system to restart.

After reboot, the Update Device Driver Wiz-
ard will appear. Follow the on screen in-
structions. When Copying Files dialog box
appears, browse to C:\Windows\System*
folder to complete the updates.

* This assumes your Windows 95 is installed in Win-
dows folder on drive “C:".

WinDows 98

No setup is required. USB technology is fully
integrated.

Winbows NT 4.0
USB technology is not supported.

USB

Like the PC Cards, Windows 98 sup-
ports the latest USB system and re-
quires no further setup but the tech-
nologies used in your system is newer
than Windows 95. So before you can
use this device, you must make some
modifications to your system as de-
scribed in the side-bar.

Once your system is setup, you should
refer to the USB devices’ manuals on
how to operate them.

USB Port
Fic.2-13
USB
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. Media

This chapter is about the system’s data storage devices (or drives):

HDD: e How to configure the system to use it
e How to replace it

CD/DVD-ROM: e How to access it

FDD (Floppy): e How to use it and care for the media




Media

INDICATORS

Whenever a drive is in use, the corresponding indicator appears:

accessing the main HDD.
accessing the FDD.

accessing a CD-ROM.
The icon does not appear if you are playing an audio CD.

eQw

Drives
Fic. 3 -1
1. CD-ROM
2. HDD
3. FDD

STATUS SCREEN
DRIVE INDICATORS

Fic.3 -2
4. CD-ROM
5. FDD
6. HDD

3-2 icons



HDD

The HDD is in a removable metal frame.

RemovinGg THE HDD Mobute
If for some reason you must remove the HDD cartridge:

1. Make sure the computer is turned off and flip down the HDD bay door.
2. Grasp the HDD bay door handle and pull the cartridge out.

INSTALLING THE HDD CARTRIDGE

To install the (new or upgraded) HDD cartridge, carefully slide it
back into the HDD bay. Be sure that the bay door handle is
securely locked in position.

2
é
Warning
Don’t try to remove the
hard disk (HDD) while
the system is on, or a
floppy disk while the
system is accessing it.
These actions may cause
the system to “crash”,
result in data loss or

damage.

RemMovVING THEHDD
Fic. 3 -3
1. grasp the HDD bay door
2. pull the cartridge out

HDD 3-3
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é
Warning
Some (usually older)
HDDs have a small
jumper switch. It must
be set to “master” or the
system may not cor-
rectly recognize the
drive. Check your
drive’s documentation.

ASSEMBLING THE HDD
CARTRIDGE
Fic.3 -4

cartridge frame

HDD

—_

(electronics face-down)

master/slave jumper
mylar shield
connector

screws

HDD

RerLACING/UPGRADING

THE CARTRIDGE

If you're too harried or a bit of a techno-
phobe, contact your dealer to purchase or
replace your current HDD with an upgrade.

L

Replacing a HDD

You can replace your HDD with another 2.5”,
12mm high IDE hard disk drive.
To assemble the cartridge,

I

Make sure the HDD's jumper pins are set
to “master” (3). - Most HDDs don’t require
any settings, but check your HDD’s docu-
mentation to be sure.

Holding the HDD (1) at an angle, plug its
pins into the connector (5). Make sure all
the pins are inserted fully.

Cover the HDD's electronic component
side with the shield (4).

Insert the HDD and shield combination into
the frame (1). As you do so, carefully fit the
edges of the shield around the screw holes
of the frame.

Secure the HDD, shield and frame with
the four mounting screws (6).
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Formatting the HDD
A hard disk must be partitioned, and formatted
before use. To partition the HDD, use the utility
from your operating system (e.g. MS-DOS's fdisk
command) to do this. To format, use the utility
from your operating system (e.g. MS-DOS's for-
mat or format/s command). Consult your oper-
ating system’s manual for more information on
its partitioning and formatting utilities.
Note: If you want to use the Save to Disk
feature, refer to Chapter 5: Power before
you partition the HDD.

After you replace or upgrade the HDD, turn the
system on and configure it for the newly-in-
stalled HDD using Setup. Refer to Chapter 4:
Firmware.

528MB or LARGER HDDs & LBA MobEe

The notebook automatically reads any HDD
528MB or larger as using LBA Mode. If you are
using a 528MB or larger HDD which was for-
matted on an older system which did not use
LBA mode, this system will not “see” it cor-
rectly. In that case, you must re-format the HDD
on this system.

SerTring Up A New HDD

FOR THE FIrsT TIME
Before you can use a new HDD for
the first time, you have to do two things:
¢ tell the computer about the HDD.

(refer to Chapter 4: Firmware)

e prepare the HDD to accept data.
(refer to your operating system manual)

Warning
Whenever you install a
different hard disk that
has a Save-to-Disk par-
tition on it, make sure
you follow the proce-
dures detailed in Chap-
ter 4: Firmware and
Chapter 5: Power.

HDD 3-5
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1.
2.

Using ACD/DVD-ROM

3-6

Insert the disk face down.
Push the tray in until it
clicks in place.

CD/DVD-ROM Drive

The CD/DVD-ROM drive appears in your
file management utility as another drive.

Aubpio CD

Audio CDs are played using a CD-
player application included in your op-
erating system. If you want to use the
CD/DVD-ROM to play an audio CD,
make sure your operating system has
the necessary drivers installed.

Fic.3-5

CD/DVD-ROM

%

CD-ROM Drivers

WinDows 95 & 98
Winbows NT 4.0

These operating systems automatically detect
and configure the CD/DVD-ROM drive.

OTHER OPERATING SysTEms (DOS)

These instructions assume you’ve already in-
stalled some version of DOS.

I

Turn on the computer and press F2 durin

the POST to enter the BIOS Setup. Chec

your CD/DVD-ROM’s make name shown
in the “Secondary Master “ option from the
Main Menu.

Open the proper directory (either TOSHIBA
or MKE) on the floppy disk*, and type:

INSTALL.EXE

*Also available on the accompanying Software &
Utilities CD-ROM'’s Drivers\DOS6X folder.
Note: If asked for “Installation Method”, the
Express Installation is recommended.
As each page appears, press Y or Enter to
confirm tEe settings.
Note: If you don’t want to install the driver in
the default directory (C:\CDROM), when the
“Specify the directory...” dialog box appears,
use Backspace to delete the current name,
then type in your preference. Remember to
start the directory name with C:\. If you get
to the “Specify the parameter to use...” page,
make sure the ()/D [CDROMO01] switch has
an asterisk(*). Then press Enter.

When the installation is complete, remove
the floppy disk and reboot your computer.
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Software DVD Setup

Winbows 95/98
Your built-in DVD drive works in the Windows 9x
environment. If you don’t install its drivers and ap-
plication software, liked the DOS and Windows
NT, it can only be treated as an ordinary CD-ROM
player To make your DVD work,

Refer to page 2-19 to enable the USB fea-

ture (for Windows 95 only).

2. Setup the video & audio drivers (see page
2-7 & 2-12))

3. Insert the DVD Drivers/Utilities CD-ROM.

(For WinDows 98, skip sTeps 4 & 5)

4. Download DirectX 5.0 from the Microsoft
web site or talk to your dealer. Then click
on Start in Windows 95. Select Run... and
type C:\DX5ENG.exe*. Click on OK to pro-
ceed (If prompted, restart the system.)

* This assume your DirectX 5.0 is English ver-
sion and is stored in drive “C:".

5. Click on Start > Run... > Browse... and
navigate to:
D:\DXMEDIA\Win95\installmedia52b.exe*.
Click on Open and then OK to install
DirectShow. This will take a moment to in-
stall. Please wait for a while until “The op-
eration completed successfully” prompted,
click on OK.

* This assumes your CD-ROM is drive “D:".

6. Click on Start > Run... > Browse... again
and navigate to:

D:\DVDA\setup.exe*. Click on Open, then OK .
* This assumes your CD-ROM is drive “D:"

INSERTING & REMOVING
A CD/DVD-ROM

To insert a CD/DVD-ROM, follow these
steps:

1.

With the notebook turned on, press the but-
ton on the front of the module to release
the spring-loaded tray.

Gently pull the tray out to its fullest ex-
tension.

Insert your CD/DVD-ROM shiny-side
down (like an audio CD).

Gently push the tray in until it clicks in
place. The CD/DVD-ROM is ready to

play.

To remove the CD/DVD-ROM, press
the same button to release the tray.

If the notebook is turned off, you can
open the tray by inserting a probe (e.g.
a straightened paperclip) into the small
hole next to the button.

CD/DVD-ROM

3-7




[Media]

3-8

MULTIMEDIA APPLICATIONS

MPEG

If you want to use the CD/DVD-ROM
to watch movies or other MPEG fea-
tures, there are two options:

1. Software- There are various software
products which make use of the raw
power of your system’s CPU to de-
code MPEG1 or MPEG2 material.

2. ZV-Port- Both PC Card sockets support
a ZV card. This card type works with
the CD/DVD-ROM and video sub-
systems to produce better quality im-
ages. However, to use it, you must in-
stall these drivers:

* The CD/DVD-ROM driver (covered in this
chapter)

Software DVD Setup (cont.)

7. Follow the on screen instructions to install
DVD Express to your system. The utility will
create a “DVDExpress” sub-folder in the
“\Program Files\Mediamatics” folder for it-
self on your C: drive unless you choose oth-
erwise. When prompted, select the region
for your system* (See table below). When
the installation is done, click on Finish.

* Windows 98 does not allow region change.
So, be careful on choosing your region
code. If you want to change your region
after setup, you first must reinstall your Win-
dows 98, then redo the entire setup again.

8. Open Control Panel > System Properties.
Double click on the item listed under
CDROM. Choose Settings page and make
sure the DMA option has a check-mark (v ).

Note: The Videodriver, DirectX 5.0, and Directshow

programs are required prior to the DVD’s installa-
tion. We also recommend to install all drivers, such

as PCMCIA before this setup.

e The audio and video drivers

DVD Regional Coding

(covered in Chapter 2: Sys-
tem).

Where

USA, Canada & US Territories

* VPM driver - built into the
video driver for Windows 95

Europe, Japan, South Africa, Middle East (including Egypt)

South East Asia, East Asia (but not China)

and Windows 98.
e ZV Card driver (supplied by 4

Australia, New Zealand, Mexico, Central & South America,

Carribbean and Pacific Islands

the ZV Card’s manufacturer).

Former Soviet Union, Indian Subcontinent, Africa,

North Korea, and Mongolia

China (but not Hong Kong)

CD/DVD-ROM



THE FDD

INSERTING/REmoOVING Froppy Disks

Gently insert a 3.5-inch disk (with its label side up) into the
Floppy drive until the disk is properly seated. Press the button on
the right of the disk drive to eject the disk.

FDD Care

Following are a few tips on the proper handling of floppies:

e Store disks away from magnetic fields and extreme temperatures. These
conditions can damage your data. It’s also a good idea to make backup
copies of software and data.

e If a disk label is already on the disk, use a soft-tipped pen to write on
the label. This prevents damage to the disk. Don’t use a pencil - its
carbon particles can rub off inside the drive.

¢ Do not remove any disk from the drive when the ﬂ LCD is flashing
(in-use).
e Do not try to clean, bend, or throw disks.

* Do nottouch or scratch any exposed portion of the disk medium. Don’t
pull open the protective door either - this lets dust get inside.

é

Warning
Do not remove a floppy
disk while the drive is ac-
tive. Doing so may dam-
age the medium or cause
a generaol protection
fault, result in data loss
and/or corruption.

FDD
Fic.3 -6

FDD 3-9
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4  Firmware

This chapter is about the notebook’s built-in software:
. the POST (Power-On Self Test) and
. the Setup utility.

If your computer has never been set up, or you are making important changes to the system
(i.e. power management features), then you should review this chapter first and note the
original settings found in Setup. Even if you are a beginner, keep a record of the settings you
find and any changes you make. This information could be useful if your system ever needs
servicing.

There is one general rule: Don’t make any changes unless you are sure of what you are doing.
Many of the settings are required by the system, and changing them could cause it to become
unstable or worse. If you have any doubts, consult your system dealer.
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STARTUP SCREEN: THE POST

Fic. 4 -1
BIOS information.
CPU type

memory status

HDD identification notice
error notice (example)
Enter Setup cue

- appesars if there is an error
7. Enter Setup cue

- appears only during POST
(#6 is not present)

Uk Wi —

4-2 POST

THE POWER-ON SEeLF Test (POST)

Each time you turn on the computer, several things happen:

o BIOS information flashes on the screen.
o the system takes a few seconds to conduct a POST,
including a quick test of the on-board RAM.

As the POST proceeds, the computer will tell you if there is
anything wrong. If there is a problem which prevents the system
from booting, it will tell you to run Setup. If there are no prob-
lems, the system will present a summary, and announce that it is
starting the operating system. Once that message appears, you can no
longer get into Setup.

PhoenixBIOS 4.0 Release 6.9
Copyright1985-1998 Phoenix Technologies Ltd.
AllRights Reserved.

Notebook Computer Model 982 Version Beta2

(xB.@2-T1-982)

CPU=AMD-K69tm)-2/333 e —
640K System RAM Passed

63M Extended RAM Passed e

@512K Cache SRAM Passed

Mouseinitialized

Fixed Disk @: 1BM-DKLA-24320 e EEEEEEE—
ATAPICD-ROM: TOSHIBADVD-ROM SD-C2102

ERROR -

Com A configurationchanged

Press<F1>toresume, <F2>to Setup e

Press<F2>toenter SETUP




FaiLING THE POST

Errors can be detected during the POST. There are two catego-
ries, “fatal” and “non-fatal”.

Fatal Errors

Non-Fatal Errors

These stop the boot process and usually indicate there
is something seriously wrong with your system. Take
the computer to your dealer or authorized service cen-
ter as soon as possible.

This kind of error still allows you to boot. You will get a
message identifying the problem (make a note of this
message!) followed by the cue:

Press <F1> to resume, <F2> to enter Setup

Press F1 to see if the boot process can continue. It
may work, without the correct configuration.

Press F2 to run the Setup program and try to correct
the problem. If you still get an error message after you
change the setting, or if the “cure” seems even worse,
call for help.

POST

4-3
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THE SETUP PROGRAM

The Phoenix Setup program tells the system how to configure
itself and manage basic features and subsystems (e.g. port con-
figuration and power management).

ENTERING SETUP

To enter Setup, turn on the computer and press F2 during the
POST. The prompt seen in Fig. 4 — 1 is usually present for a few
seconds after you turn on the system. If you get a “Keyboard
Error” (usually because you pressed F2 too quickly) just press F2
again.

If the computer is already on, reboot using the Ctrl + Alt + Delete

combination and then hold down F2. Setup’s main menu will ap-
pear.

SETUP SCREENS
The Setup interface looks like a “windows” screen:

Along the top of the screen is a menu bar with five (5) menu
headings. When you select a heading, a new screen appears. Scroll
through the features listed on each screen to make changes to Setup.

Instructions on how to navigate each screen are in the box along
the bottom of the screen. If these tools are confusing, press F1 to
call up a General Help screen. Then use the arrow keys to scroll
up or down this page.

4-4 setup



Main Advanced Security Power Boot Exit
SystemTime: [ MJ26:15) Item SpecificHelp
SystemDate: [01/20/1999] )
<Tab>,<Shift-Tab>, or
<Enter>selectsfield.
» PrimaryMaster [IBM-DKLA-24320-(PM)]
PrimarySlave None
SecondaryMaster TOSHIBADVD-ROMSD-C2102-(SM
SecondarySlave none
MemoryCache: 512KB
SystemMemory: 640KB
ExtendedMemory 64512KB
F1 i) # =]
ESC fead Enter F1@

The “Item Specific Help” on the right side of each screen explains
the highlighted item and has useful messages about its options.

If you see an arrow (“ » ”) next to an item, press Enter to go to a
sub-menu on that subject. The sub-menu screen which appears
has a similar layout but the Enter key may execute a command.

MAIN MENU

Fic. 4 -2
The Setup menus shown in this
section are for reference only.
Your computer’s menus will
indicate the configuration ap-
propriate for your model and
options.

main menu
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M

Switching Hard Disks

Every time you install a differ-
ent hard disk in the notebook,
it should be (re)configured, un-
less Auto is selected.

M

Auto Limitations
The Auto feature may provide
a different set of parameters
for the same hard disk at dif-
ferent times. However, it
should be reconfigured with
the same parameters you got
the first time. If you use a dif-
ferent set of parameters, it may
be impossible for you to read
any data on the hard disk.
Make a record the original
configuration parameters for
your hard disk for future use.

main menu

MORE ON SETUP

Following is additional advice on portions of the Setup, not cov-
ered in the Item Specific Help.

TIME AND DATE tan menw)

The hour setting uses the 24-hour system (i.e., @@ = midnight; 13
= 1 pm). If you can change the date and time settings in your
operating system, you will also change these settings. Some ap-
plications may also alter data files to reflect these changes.

PRIMARY MASTER an Menw)

Pressing Enter opens the sub-menu to configure the main IDE
HDD which fits into the notebook’s HDD bay. Refer to Chapter
3: Media for more on these modules.

TyPe

(MAIN MENU >PRIMARY MASTER)

This setting has several options for choosing which method Setup
will use to detect the hard disk:

Auto (Default setting) This is the easiest solution. It allows Setup to
determine the hard disk’s type and other information when you
press Enter. It automatically loads the information into the BIOS.

None No hard disk is installed. With this option, the system will

require a floppy disk to supply the bootup information.



CD-ROM
User

The system expects a CD-ROM or DVD-ROM.

This allows you to fill in the Cylinders, Heads and Sectors/
Track fields. The size (MB) field is automatically calcu-
lated based on this information. The information for all these
fields should be printed on the hard disk itself, or in its ac-
companying documentation.

MuLTI-SECTOR TRANSFERS

(MAIN MENU >PRIMARY MASTER >Type >CD-ROM & USER)

This feature determines the number of sectors in each block that
can be transferred together. The “Auto” Type setting selects the
optimum number.

LBA Mope CONTROL
(MAIN MENU >PRIMARY MASTER >Tyre >CD-ROM & USER)

If your hard disk is larger than 528MB (unformatted capacity),
enable this feature. The “Auto” Type setting enables this setting
if the disk is large enough.

32 Bit I/O

(MAIN MENU >PRIMARY MASTER >Type >CD-ROM, & UsEr)

This setting allows you to enable or disable 32 bit IDE data
transfers. The default setting is set to “Disabled”.

——
&\

Warning

If you enable LBA mode
while setting the HDD
parameters manually, be
sure to enable it each
time you use the same
hard disk. If you don’t,
you may encounter read/
write errors.

M

When to Use LBA

The “standard” or ATA mode of
“seeing” HDDs is inadequate
for drives larger than 528MB.
LBA mode corrects this and al-
lows for hard disks up to 128GB.
ATA and LBA modes overlap.
So if LBA mode is not activated
when a HDD is first formatted,
sections may not be readable
under the LBA system. (This
does not matter with 528 MB or
smaller HDDs).

If you're using a HDD not for-
matted using LBA mode, do not
use the “Auto” setting.

main menu 4-7
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ADVANCED MENU
Piuc & Piay O/S

M (ADVANCED MENU)

Plug & Play OSs

Most operating systems do not
support Plug & Play. This in-
cludes Microsoft’'s DOS, Win-
dows 3.1x, Windows NT 4.0 and
IBM’s OS/2 Warp. However,

As this manual went to press, only Microsoft Windows 95/98 fam-
ily supported Plug & Play function.

future versions of these systems Main Advanced Securit Power Boot Exit
may include Plug & Play. So you
should check your O/S docu- Item SpecificHelp
mentation to be sure.
Setup Warning

If the operating system doesn't Setting items on this menu to incorrect Select'Yes'if you
support Plug & Play, this switch values may cause your system to malfunciton. are using a Plug &
must be set to “No” or your Play capable
audio system and other fea- Plug & Play O/S: {Ves| operating system.
tures may not work. : . . .

Reset Configuration Data: [Auto] Select‘No' ifyou

need the BIOS to
PS/2 Mouse: [Auto Detect] configure non-boot
ADVANCED Meny » /0 Device Configuration devices.
FiG. 4 -3 g
F1 3 # 3]
ESC g Enter F1&

4-8 advanced menu



I/O DEevice CONFIGURATION (aovaceo Mesu)
Press Enter to open the sub-menu to configure port connections.

=

I/0 Device Configuration

Item Specific Help

Fic. 4 -4

Serial port A: [JAuto | Configure serial port A
Serial port B: [Auto] using options:
Mode: [Normal] .
Parallel port: [Auto] [Disabled] .
Mode: [ Bicirecion] No configuration
Floppy disk controller: [Enabled] [Enable]
User configuration
TV port: [NTSC]
[Auto]
BIOS or OS chooses
configuration
F1 20 +# )
ESC Log Enter F1&

advanced-peripherals

ADVANCED SuB-MENU,
1/0O Device CONFIGURATION

4-9
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SeriAL PORT A

(ADVANCED MENU >1/O Device CONFIGURATION)

The “Auto” type setting allows Setup
or OS to configure this port. If you
don’t plan to use this port, you can set
this line to “Disabled” to conserve
power.

SeriAL PORT B

(ADVANCED MENU >1/O Device CONFIGURATION)

The “Auto” type setting allows Setup
or OS to configure this port. If you don’t
plan to use this port, you can set this
line to “Disabled” to conserve power.

MobpEe (NORMAL)

(ADVANCED MENU >1I/O Device CONFIGURATION >SERIAL PORT B)
There are several modes available if
you set the serial port B to “Enabled”.
Make sure the mode you choose is sup-
ported by the device with which you
want to communicate. “Normal” mode
assigns it to be COM2 port. Fast IR
(FIR), as the name implies, is the most
powerful option followed by IrDA(SIR)
and then ASK-IR.

4-10 advanced-peripherals
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Serial Resources
If you are not planning to use these serial ports,
you can disable them (by choosing “Disabled”).
This way you can assign resources to another
device, e.g. a PC Card device.



PARALLEL PORT

(ADVANCED MENU >1/O DEvice CONFIGURATION)

The “Auto” type setting allows Setup
or OS to configure this port. If you

%% don’t plan to use this port, you can set
this line to “Disabled” to conserve
Parallel Modes power.

Although most devices on the market use Stan-

dard mode (i.e. Output only mode); the default Mobpe (LPT)
“Bi-directional” setting also supports Standard
mode. (ApvancED MEenu >1I/O Device CONFIGURATION > PARALLEL PORT)

There are several modes available
once you have enabled the parallel
port.

Output only (Standard)
Bi-directional

EPP (version 1.9)

ECP (Extended)

You should check your parallel
device’s documentation to see which
one it can use.

advanced-peripherals 4-11
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SecURITY MENU
SET SUPERVISOR PASSWORD & SET USER PASSWORD (Securiry Menw)

Passwords can be up to seven (7) characters and/or numbers (but
not symbols). When creating a password it must be entered twice,

the second time for confirmation.

If you forget or lose a password, consult your dealer or service center.

Main Advanced ecurity Power Boot Exit
SECURITY MENU Item Specific Help
Fic. 4 -5 Set Supervisor Password Is: Disabled Supervisor Pasword
User Password Is: Disabled controls access to
) the setup utility
Set Supervisor Password [
Set User Password [Enter]
Password on boot: [Disabled]
Fixed disk boot sector: [Normal]
Diskette access: [Supervisor]
F1 0 -+ F9
ESC R Enter F19

4-12 security menu



SET SUPERVISOR PASSWORD (Securiry Menw)

Supervisors have unrestricted access to the system and can as-
sign a “User” password.

Only a supervisor can change a “Supervisor” password. If you
leave the field empty, both the Supervisor and User passwords
are disabled and erased.

SET USER PASSWORD (SEcURITY MENU)

To use this feature, a Supervisor password must be set first. Only
the supervisor (using the Supervisor password) can set and change
the User password. To disable the User password, enter the ex-
isting password first and leave the new password fields blank.

If you enter the system with the User password, you are denied
access to:

specific disk & drive information

I/O device configuration (peripheral & port)

the “Advanced” menu

the “Security” menu (except for user password)

PASSWORD ON BOOT (securimy Menv)

When this is “Enabled”, the system will ask for a password each
time you turn on the system or reboot. Type either password and
then press Enter.

The system allows three attempts. If the wrong password is en-
tered again, the system locks and must be restarted.

security menu
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security menu

Fixep Disk BOOT SECTOR (securmy Menu)
If this feature is active, you will get a warning message

Hard drive not installed

If operating system not found,
re-install hard drive.

Hit any key to exit.

whenever Boot Sector 0 is different from the one recorded. This
includes re-partitioning or reformatting the hard disk. You must
turn off the “Write Protect” feature to preform those functions or
install a different hard disk.

If boot sector protection is not enabled (i.e. set to “Normal”),
make sure that the new hard disk is not infected with viruses.

DISKETTE ACCESS (Securimy Menw)

This feature determines who control the accessability to diskette
drives. The default “Supervisor” setting assigns the supervior



Power MENU

In this menu, you can choose among the preset power saving
schemes or customize your desired settings. Before you adjust
the settings, we suggest a review of the power management
system in Chapter 5: Power.

Note: The Fn + £) combination activates Save to Disk (if a file or parti-

tion has been preapared).
The Fn + %, combination activates Suspend (to RAM).

[Fil

Main Advanced Security Boot Exit
ltem Specific Help
Power Savings: [ Disabled |
. . Maximum Power Savings
Standy Timeout: Disabled conserves the greatest
Auto Suspend Timeout: Disabled amount of system power.
Suspend Mode: [Suspend] Maximum Performance
conserves power but
Hard Disk Timeout: Disabled allows greatest system
Video Timeout: Disabled performance. To alter
these settings, choose
. Customized. To turn off
Resume On Modem Ring: [Enabled] power management, choose
Resume On Time: [Disabled] Disabled.
20 -1+ F9
= Enter F19

ESC

Power MENU
Fic. 4 -6

power menu
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power menu

Power SAV/NG (Power MENU)

This is the “master switch” for the power savings system. If you
want to turn the power management off, set it to “Disabled”.

SUSPEND MODE (Powek Menu)

Use this menu to control the Suspend power management sys-
tem. If you want to use the “Save to Disk” method, you must have
set up a Save to Disk file or partition as described in Chapter 5:
Power.

Resume ON Mobem RING, Resume ON TIME

(Power MENU)
Use these menus to control how the system will be reactivated

from Suspend (to RAM) mode. This does not apply to Save to
Disk mode.

If you want to resume from a ring-in (i.e. a modem singal),
make sure the “Resume On Modem Ring” is set to “On”. If you
want to specify a specific period of time for the system to wake
up, make sure to enable the “Resume On Time” switch and
specify a time period to your preference in the “Resume Time”
and/or “Resume Date” menus.



. Power

This chapter is about the power system, both hardware and software:

Hardware e AC adapter (also see page 1-7)
* battery pack (also see page 1-11)

Software e Setup utility parameters (also see page 4-14)
* power & battery management controls (also see pages 1-12 & 1-14)
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TABLE5 — 1

STATUS SCREEN INDICATORS

5-2 interface

THE INTERFACE

The status screen has three icon groups about the Power system,

Suspend to RAM

Indicator Meaning Effect
Full power All subsystems are fully powered.
n Sleep mode The CPU clock is on "hold", all subsystems are in a

reduced-power mode, and the LCD is off.

The CPU and other chips are turned OFF, RAM is
refreshed slowly, system fan is OFF, peripheral devices
and ports are in power-saving mode.

Battery > 80%
Battery < 80% to 20%
Battery < 20%

Battery empty

Battery has more than 80% power, considered "Full".

"Low" battery range, rechare with the adapter

30088 * ¥
|

~ [y

lines & frame blink

charging

Steady lines correspond to charge level, cycling lines
indicate "dumb" battery charging.

all lines & frame blink

system problem

Re-insert or replace the battery, if the problem
continues, consult your service representative.
Do Not Attempt to Repair the Battery.

y

AC-in

System is receiving AC power.

and two hot-key controls:

/N suspend/standby

activates “Suspend” (to RAM).




é freeze activates “Save to Disk” if the Save to Disk
partition/file is available, otherwise acti-
vates “Suspend” (to RAM).

Power HARDWARE

You can operate the notebook on either AC or battery power. The
next two sections are about how to use these power sources and
other AC/battery power related information.

AC Power

The notebook comes with an AC power cord and a universal, auto-
switching power adapter. You can use the adapter anywhere the
voltage is steady, between 100 and 240 volts.

When the adapter is connected to a power source and then to the
computer, the #-~ icon on the status screen appears to indicate the
system is receiving AC power. To use the AC adapter:

1. Plug the power cord to the power adapter.

2. Plugthe power adapter
to the adapter port on "EI
the computer’s right [
panel.

3. Plug the power cord into a wall outlet.

4. Press the power button O for one sec-
ond to turn the system on.

N1/

Warning

Only use an approved
adapter. The wrong
adapter could damage

the computer.

COoNNECTING AC ADAPTER

Fic. 5 -1

adapter
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battery

BATTERY POWER

The notebook comes with a rechargeable battery pack. You can
get a replacement pack from your dealer.

FIrRsT-TiME USe & STORAGE

If you don’t use a battery pack for a long time (about three weeks),
it should be discharged completely and then recharged. The bat-
tery pack that came with your new computer may have been in
storage or shipment for some time. So, we strongly recommend
that you follow these steps when you receive this computer or if
you have not used the battery pack for a long time.

1.
2.

Install the battery pack in its comaprtment (if it’s not already there).

Make sure that the AC power source is plugged in. Refer to the AC
Power section for details. Turn on the system and press F2 to enter
Setup. (If you are not sure how to do this, refer to Chapter 4: Firm-
ware.)

. Open the Power menu and set Power Savings to “Disabled”. This pre-

vents automatic Suspend when the battery is low.

. Save the settings by using the “Exit Saving Changes” option in the Exit

menu.

. Make sure that your operating system does not activate Advanced Power

Management (APM). If you are using Windows 9x, reboot using
“Command prompt only”.
Note: if your hard disk is not bootable, insert a bootable floppy disk in
drive A: before rebooting.



6. After the system finishes booting, detach the AC power source. Discharge
the battery completely by leaving the system on for about two (2) hours,
until the system shuts itself down. Ignore any low power warnings.

7. Once the system has turned itself off, plug in the AC power source to
recharge the battery. For a faster charge, leve the system off while charg-
ing. The icon flashes while the system is charging. When the bat-
tery is full, the icon is steady, with all bars present. To figure out how

long it takes to recharge the battery, refer to Appendix A: Specifica- N4
tions. &\
8. Turn on the computer and press F2 to enter Setup. Open the Power Warning
menu and reset your preference. Save the setting and reboot. Always save your work
before changing the
battery.

Do not attempt this
function without enter-
ing Save to Disk or turn-
ing off the system. Oth-
erwise you will loose all
unsaved data.

battery 5-5
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REMOVING THE BATTERY

Fic. 5 -2
1. slide the power bay
latches in

No

grasp the battery tab
3. pull the battery out

5-6 battery

INSTALLING & REMOVING A BATTERY PACK

Before installing or removing a battery pack, avoid the chance
of data-loss by saving your work first and then using one of
these methods:

e Shut down the system.

e Use Save to Disk mode.

e Put the system in Suspend (to RAM) mode and make sure power is
available from the AC adapter.

To install a battery pack:

1. Turn the computer upside down and open the battery compartment
by releasing the latch and sliding the cover to the right.

2. Remove the used battery (if present) by pulling on its tab.

3. Remove the battery from its packaging.

4. Slide the battery into the compartment. You should feel a slight “click” as
the connectors in the notebook slide into the battery pack’s slots.

5. Replace the compartment cover and secure its latch.




3k

Partial Charges
If you don’t have time to charge the battery fully,
try to make sure the battery has enough power to
complete the Save to Disk process (if you’ve con-
figured your system to use it). You must charge
the battery to at least the [ level.

UsING & CHARGING THE

BATTERY PACK

When the system is using battery power
only, the status screen indicates the
battery’s charge. If the icon has only 1
bar left (less than 20%), the battery is
low. If this happens, save your work im-
mediately and either plug in the AC
adapter and/or replace the battery pack.

When the system receives AC power,
both #~ and a flashing icon appear
to indicate AC-in and battery charging.
When the battery is fully charged, the
icon is steady. Refer to Appendix A:
Specifications for a guide to battery life
and figuring recharge times.

“SMART”& “DUMB” BATTERIES

The status screen icons appear the same
for both battery types. However the val-
ues for “dumb” batteries are much less
accurate.

Though not shown, the system detects
Low battery status (about 10%) for both.

Warning
If your system does not
have a “smart battery”
(e.g. aMoliCel ME202BB),
Windows APM will
register power levels as ei-
ther20% for Low or80%
for all other states.

battery 5-7
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PowER MANAGEMENT

H ARDWARE (BATTERY STATUS & WARNINGS)

When the POST is finished, the status
screen icon indicates the approximate
battery charge. When the system detects
a level of about 10% (sometime after
the  icon appears) the system starts
making a warning “beep”. When this
happens, save yourwork immediately and
plug in the power adapter.

If you don’t have access to an AC power
source, shut down the system and re-
place the battery pack or recharge until
the power level is at least 40% ().

Note: The battery charge level is vis-
ible after the system completes the
POST. The battery recharges when the
system is OFF.

power management

lI
[]

Save to Disk Setup
When the BIOS instructs the system to “Save to
Disk”, it makes use of a special file or partition on
the HDD. This is created and managed by the
PHDISK utility found on the same floppy as for
the CD-ROM driver. Another copy is on the Driv-
ers/Utilites CD-ROM.

SpACE

Both paritition and file methods occupy the same
amount of space on your HDD. The PHDISK setup
utility will automatically define the space to be reserved
according to your system memory size. But if you pre-
fer to define yourself, the size of the space must be
greater than the total size of the memory (DRAM) and
the notebook’s video RAM. A typical setup’s space
requirement might be:

memory type size in KB sizein MB
system 65,536KB 64MB
video 4,096KB 4MB
total 69,632KB 68MB
recommended* 70,656KB 69MB

* The recommended space should always be about
1TMB more than the total calculated. The extra
MB is for data from other chip registers.

(1MB = 1024KB)

Check the specifications for your system be-

fore you run the PHDISK utility.

Note: If you want to use different setup method
(i.e. change from partition to file method, or vice
versa) after setup, you must delete the existing par-
tition or file before you can use the new setup
method.
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Save to Disk Setup (cont.)

THE PARTITION METHOD

Since this method requires you to configure your
HDD, you must make sure you have enough
unpartitioned, unformatted hard disk space to
accommodate the size of the partition you expect
to have before this setup. Follow these steps to
prepare the partition:

1. Boot up the computer from a bootable disk.

2. Insert the PHDISK Utility floppy.
3. Run PHDISKP.EXE at the DOS prompt, type
a:>PHDISKP [Enter], type “1” [Enter], then

* to use the default setting, press [Enter]

e to make a partition the size you prefer ( e.g.
for a 37MB=37,888KB partition), type
“37888" then press [Enter]

4. When finished formatting, choose “3”, then
press any key to reboot the system.

Note: When run your operating system’s partition
utility (e.g. MS-DOS's FDISK), it will tell you that
it has found a “Non-DOS” partition. Do not do
anything to this partition, and be careful not to
format the “Non-DOS” patrtition.

Other Controls — Reformatting (partition only)
If your Save to Disk partition becomes corrupted
or develops too many “bad sectors”, you should
reformat the partition by typing,

a:>PHDISKP [ENTER], type “1” [Enter]

When finished reformatting, choose “3”, then

press any key to reboot the system.

Low BATTERY & SAVE

When the Low battery warning starts, you
have about 10% of battery power left.
Then, the computer goes into Save to Disk
or Suspend mode (if you haven’t given
the system more power).

The Baitery Low line in Power Savings (see
Chapter 4: Firmware) has two options:

Save to Disk - System status information
is recorded to a special file
or partition on the HDD and
then the system turns OFF.
This requires the PHDisk

utility (see the sidebar).

— Information is saved to the
RAM and the system goes
into low power mode.

Suspend

If either of these options starts, the bat-
tery is “fully” depleted, though it main-
tains a small, safety, reserve.

If the battery depletes its safety reserve,
the system can’t be turned on and any-
thing not saved to disk is lost. In this case,
replace or enhance the power supply.

Warning

If you haven’t set up
the system for Save to
Disk, or if the space re-
served for the Save to
Disk partition isn’t
large enough, the sys-
tem will default to the
Save to Disk file (if
present and large
enough) or to Suspend
mode. If the system
uses Suspend mode,
your unsaved data will
be lost when power is
turned off.

save to disk 5-9
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save to disk

FIRMWARE (serr Conreors)

The Power menu in Setup controls how
Suspend (to RAM) or Save to Disk is ac-
tivated. Refer to Chapter 4: Firmware
on how to setup these modes.

Setup’s Ttem Specific Help describes the
power management control on the
Power Savings page. You can see the
default time-out values as you try the
different settings on the “Power Savings”
line.

SAVE TO Disk

Pressing Fn + 2 or a system time-out
activates this.

When Save to Disk is enabled, the com-
puter makes a starting beep to let you
know when current work is being stored
into the specially-reserved hard disk area
(partition or file). When it’s finished, the
system shuts down.

To resume work, press the ON/OFF
button to turn the system back ON. The

ml
[]
Save to Disk Setup (cont.)

THE FiLe MeTHOD (FOR FAT16/FAT32 FILE SYSTEM ONLY)
This is a more flexible means of preparing your hard
disk for the Save to Disk power saving system. How-
ever, itis not compatible with all types of file system.
To setup this file you should,

1. Make sure your hard disk is defragmented (there
are numerous utilities available for this).

2. Reboot the computer in the DOS mode.
. Insert the PHDISK Utility floppy.
4. Run PHDISKF.EXE at the DOS prompt, type
a:>PHDISKF [Enter], type “2” [Enter], then
* to use the default setting, press [Enter]
¢ to make a partition the size you prefer ( e.g.
for a 69MB=70,656KB partition), type
“70656" then press [Enter]
5. When finished creating, choose “3”, then press
any key to reboot.

Note: When finished, the utility will save the file,
SAVE2DSK.BIN, as a hidden, system, and read-only
file in your root directory of drive “C:”.

Other Controls — Deleting (partition or file)

If you want to remove the partition or file, type
a:>PHDISKP [ENTER] (for partition method),

or a:>PHDISKF [ENTER] (for file method), then
type “2” [Enter]. When finished deleteing,
choose “3”, then press any key to reboot.

Note: This deletes the contents of the partition if you

use the parititon method. To make the partition DOS-

usable, next use DOS’s FORMAT utility.



system will return to the state before it went into Save to Disk and
turn on all devices.

Security Note: If you setup a password in Setup, you will need it to
resume from Save to Disk.
Ring in Note: If you want a ring-in from a fax-modem to wake the

system, do not use this setting.

SUSPEND

Activated by pressing Fn + %  or a system time-out.

In this mode, the computer is powered down, but still maintains
power to the DRAM to preserve the system state information stored
there.

Pressing any key reactivates the computer. However, each time
this happens, you risk depleting the battery beyond its safety re-
serve and losing any data not saved to a disk.

Security Note: Passwords are not needed to resume from Suspend. If
you want password protection, use the Save to Disk
alternative.

Ring in Note: The system will wake if a ring-in is detected from a fax-

modem or an activated serial (or other COM) port.

Warning

Do not remove or
change the PC Cards
while the system is in
Suspend Mode.

The slots are turned off
and any change in the
system configuration
may cause problems
when the computer
comes back on.

suspend 5-11
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APM

SOFTWARE (UTILITIES)

Your system is designed to work with
three power management utilities: APM,
and two optional utilities form Phoenix.

APM

Developed by Microsoft and Intel this
utility is embedded in the Windows 9x
operating systems. However, the embed-
ded APM is unable to utilize the full
range of options available in Phoenix’s
Setup-based power management system.
Use the battery icon on the
(Windows )control panel to access APM
(in Windows 9x). For best results, use
“Advanced” settings.

For more information about APM, refer
to your operating system documentation.

Note: If you are using a “dumb” bat-
tery, no utility can offer accurate infor-
mation about the charge levels.

3k

Additional Power Management
You can conserve power by reducing the amount
of disk caching Windows 9x does. From the
Control Panel, select System. From the Perfor-
mance tab, select File System.... On the Hard Disk
tab, select “Mobile or docking system” under
“Typical role of this machine:”. Your system
performance may not be as fast, but the battery
should last longer.



Installing SystemSoft PowerProfiler
To install PowerProfiler for Windows NT 4.0,

1.
2.

Insert the Software & Utilities CD-ROM.

From the Start menu, select Run.... Then
Browse... and Navigate to:

D:\drivers\nt40\apm\setup.exe*
*This assumes your CD-ROM is drive “D:”.
Click on Open, then OK and Next to proceed.

Click Next to accept the default installation di-
rectory. Or click on Browse... to select an al-
ternative directory.

After the installation is complete, select Yes to
read the README file. Or select No to pro-
ceed.

Click on Finish to restart.
. PowerProfiler [ 1]

{Siandad| Advanced | Batlers |

Paer Management: Battery Only  »

- Timers/Device C:

Best Conservatian Best Pefomance | Castom |
Save as Custom

1Min =] Display power down
=i

1Min =] Hard dive power down oon e

[~ Suspend C:
Suspend Now
¥ Show suspend command in start menu

oK Cancel Lol About

SYSTEMSOFT POWERPROFILER

Available in Windows NT 4.0, SytemSoft’s
PowerProfiler utility provides a full
range of power management options.
It allows you to set power management
parameters and various alarms to
monitor declining battery power and
control overall power consumption.

The installation adds an icon, Suspend,
in the Start menu, and another icon,
PowerProfiler, in the Programs group.
PowerProfiler is set to automatically load
with Windows NT. Once activated, a
small battery icon appears on the right
bottom corner of your screen. You can
use this icon to invoke PowerProfiler or
to put the system in Suspend.

POWERPROFILER
Fic.5-3
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. Extras

This chapter is about add-ons and extra features available with your system:

Hardware * Memory (also refer to page A-3)
* Port Replicator (optional)

Software ¢ improved TouchPad drivers (also see page 2-5 & 2-6)
e FIR driver for IrDA
* Audio
¢ PC Card

If you plan on increasing your system memory, be sure to read the “Memory” section before

you make any purchases.

If you use the TouchPad frequently, the enhanced driver allows you to make it even more user
friendly. However, it doesn’t have any effect if you're using an external pointing device.

6 -1
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MEMORY

You can upgrade your notebook’s memory to as much as 256MB.
This involves opening the memory compartment and installing
one or two DIMMs.

e\,’ﬁ You can install these modules in either one socket or both sock-
Warning ets (in any order and any size combination).
Check with your dealer Socket requirements:
to make sure installing up to 256MB maximum using one or both sockets
RAM piEl dle Socket 1 & Socket 2 requirements:
CHIELETIE F7ETy TORVTEL 7 * 16MB, 32MB, 64MB or 128MB modules
¢ 144-pin SO-DIMMs
* 3.3-volt
® TSOP package
Wz ¢ SDRAM DIMMs
&\ — rated at 10ns or faster
Warning
Make sure each module
meets all of the criteria Make sure you put the correct type in each socket.
for the socket it will be
used in.

6-2 memory
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Installing DIMMs
If you install additional memory by yourself,
1. Make sure the system is turned off, you are
wearing an antistatic wrist strap (available
from most computer supply dealers) and
you are in a dust/smoke-free environment.

2. Place the computer on a clean, dry, level
surface.

3. Using a small Philips-head screwdriver, re-
move the anchor screw (1) from the memory
bay cover and set the cover aside (2).

4. Insert a DIMM in either slot at about a 20°
angle (3). Grooves on the sides of the mod-
ule allow you to insert it only one way.
Make sure it is seated as far into the slot as it
will go.

5. Gently push down on the module (4) until its
lock-catches snap into place. DO NOT
FORCE IT. The module should fit in without
much pressure. If there is a lot of resistance,
check to make sure the DIMM is properly
seated.

Install the second module in the same way.
Replace the memory bay cover (5).

After changing the RAM configuration, run
Setup so the new total can be registered in
the CMOS (refer to Chapter 4: Firmware).

&R

2
é
Warning
Do not touch the
module’s edge connec-
tors. Even the cleanest
hands can leave oils
which may attract cor-

rosive particles.

INSERTING THE DIMM

Fic. 6 — 1
Follow the instructions on

the opposite side-panel.
Modules can be inserted in
any order.

memory 6-3
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TouchPad

ToucHPAD

If you want to take full advantage of
the TouchPad’s capabilities, you need
to install the Alps Glidepoint software
which comes with your system. This
utility is on the accompanying Software
& Utilities CD-ROM.

GESTURES

Glidepoint adds several new tabs to
the Mouse Properties control panel.
It also enhances the original Buttons
and Motion tabs.

CusTOMIZING (GESTURES

To customize TouchPad features in
Windows operating systems , use the
Buttons tab in Mouse Properties of Con-
trol Panel:

1. From the Start menu, select Settings >
Control Panel.

2. Double-click on the Mouse icon.

)

Glidepoint Installation

Winbows 95 & NT 4.0

I

From the Start menu, select Settings > Con-
trol Panel.

Double-click on Mouse to open Mouse
Properties.

Select General (tab), and then click on
Change... (button).

The Select Device screen will appear, then
Click on Have Disk...(button).

Insert the Software & Utilities CD-ROM,
then click on Browse... and navigate to:

d:\drivers\win95\touchpad\apoint.inf*
or d:\drivers\winNT\touchpad\apoint.inf*
*This assumes your CD-ROM is in drive “D:".

Follow the on-screen instructions. When
Alps GlidePoint screen appears, click on
Ok to copy the driver files to your system.

Note for NT4.0: This driver also makes
changes to the Keyboard Port driver. When
prompted for confirmation, click Yes to
continue the installation anyway.

Click on Close. When asked for a reboot,
do so.

After system restarts, you should see the
TouchPad icon in your taskbar next to the
clock.



&

GlidePoint Installation

WinDows 98

1.

When the Mouse Properties page ap-
pears, use the on-line help to get infor-
mation about each feature. To config-
ure other common features, click on

Click on Control Panel > System, then De-

vice Manager (tab).

Click the plus sign next to the Mouse
category, then double-click the cur-
rent device name (e.g. PS/2 Com-
patible Mouse Port).

Select Driver (tab) > Update Driver....

The Update Device Driver Wizard
screen will appear, click on Next and
insert Software & Ultilities CD-ROM.

Choose "Display a list of all the driv-
ers...", then click Next> (button).

Click on Have Disk... (button), then
click on Browse... and navigate to
d:\drivers\win98\touchpad\apoint.inf*
then click OK (twice).

*This assumes your CD-ROM is in drive “D:".
When Alps GlidePoint appears, click
on Next> (twice) to copy the driver
files to your system.

Click on Finish, and then on Close to
return to Device Manager.

Click on Close again, you should see
the TouchPad icon in your taskbar
next to the clock.

other tabs.
Mouse Properties 2] I
Gestures | Sound | Eazy Launcher | Easy Capture |
Buttons | Pointers | Motion | Orientation | AutoJumps | Tapping

— Buttong

1
Fym

Left Buttan

Click < l

Right

Eoth Buttons

Shorteut Menu ‘l

Auto Serall ~ l

— Double Click Speed
Test &rea

DOptionz |

Detault

=

ALPS

QK

Cancel | Ll

Mouse PROPERTIES
Fic. 6 -2

TouchPad 6-5



[Extras]

FIR

FIR ror THE IRDA

Your notebook includes an infrared se-
rial port. The accompanying Software
& Utilities CD-ROM also includes a FIR
driver for the IrDA port. This driver
only works with Windows 95, so its
included in that operating system’s
driver folder.

To use it in Windows 95, you must also
download the W95ir.exe driver from
the Microsoft web site or talk to your
dealer. Then, follow the instructions
on the side-bar to perform the installa-
tion. Windows 98 does the resource al-
location automatically but Windows NT
4.0 provides no support of this device.

For more detail information on the in-
stallation procedure and system set-
tings, please refer to the
RELNOTES.DOC file included in the
FIR subfolder on the Software & Utility
CD-ROM. You can open the file with
the Wordpad utility included with Win-
dows 95.

)

Installing FIR for IrDA Drivers

Winbows 95/98

1.

Choose Serial Port B’s mode settings as “FIR”
in the BIOS setup (see Chapter 4: Firmware).

When the system starts, the Update Device
Driver Wizard will appear.

For Windows 98, follow the on-screen in-

structions. When finished, reboot the sys-
tem for the changes to take effect.

For Windows 95, click on Next > Other Lo-
cations > Browse, and navigate to:

d:\drivers\win95\fir

Follow the program'’s dialog boxed. If asked
for “Insert Disk”, redirect to

d:\drivers\win95\fir\smcser.inf

Locate and double-click the W95ir.exe
(download this driver from the Microsoft web
site or talk to your dealer) file icon to launch
self-extracting. The extracted files will be
saved in MSIR20 folder on drive “C:”.

Browse to C:\MSIR20 and double-click the
setup.exe file. When prompted, choose
“SMC IrCC(Fast Infrared) Hardware and
Driver(COM2)”, and “use default ports”.

Using Windows Explorer to navigate to:
d:\drivers\win95\fir\smcirlap.inf

Click right mouse button and choose In-
stall. When asked for smcirlap.vxd, redi-
rect to the same location to continue the
setup. When finished, reboot the system for
the changes to take effect.
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Installing CardWorks

WinDows 95

The CardWorks utility replaces Windows 9x’s PC
Card utility with enhanced support. However,
you should install this after you have activated
the PC Card utility in Windows 95. To isntall,

1.
2.

Make sure your PC Card sockets are empty.

Insert your Software & Utilities CD-ROM,
then use the Windows Explorer to navigate
to d:\drivers\win95\pcmcia\setup.exe*.

*This assumes your CD-ROM is drive “D:".

Follow the on-screen instructions. When asked,
use default (i.e. select either Next or Yes). When
prompted, allow the system to restart. After
reboot, the pc cards push the CD-ROM back
two letters (i.e. if the CD-ROM is drive “D:”, it
will become drive “F:”, and the pc cards will
be the new “D:” and “E:” respectively.)

Note for SRAM/FLASH Card

a.

On step 3, you must choose the “Custom” setup
type instead of “Typical”. When asked, say
Yes to update files. Check “SRAM Cards” and
“FLASH Cards” under Mass Storage Device
option when prompted.

After reboot, insert your SRAM or FLASH
card. Please wait for a while (can be a few
minutes) for the system to detect the card.
Click on View > Properties > Drivers (tab)
Choose “Change Card Driver”, and select
“Use CardSoft Mode” under Card Driver
option, then click on OK. When asked, re-
move and reinsert the card for the changes
to take effect.

CARDWIZARD (CaroWorks)

The CardWizard utility is only supplemen-
tal for Windows 95 & Windows NT 4.0
(though highly recommended for the lat-
ter). It gives you information about the
status of the cards and sockets, trouble-
shoots card configuration problems, and
resolves resource conflicts.

Although Windows 95 allow hot
inserion or removal of PC Cards, the
accompanying utility CardWorks pro-
vides better resource support. In Win-
dows 95, start CardWizard from the
taskbar (Start > Programs >
CardWorks > CardWizard).

Windows NT 4.0, on its own, won't al-
low “hot” insertion or removal of PC
Cards. CardWizard overcomes this de-
ficiency. However, before removing a
card, you should click on Stop from
the CardWizard’s Action menu. This
makes sure no applications are using
the card, which might cause a problem
if the card is removed.

pc cards
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Formatting in Win-
dows NT4.0
Windows NT 4.0 has the nec-

essary formatting utilities built
in.

pc cards

6-8

In Windows NT 4.0, start CardWizard
from the taskbar (Start > Programs >
CardWizard for Windows NT).

For more information on CardWizard
features, you can click on CardWizard’s
Help icon in your taskbar close to the
clock or go to the “Help” menu if you
have already activated CardWizard.

UsING CARD WIzARD

CardWizard can detect a card’s installa-
tion and “correct” the system resources
allocation. Press the Wizard button for
more information. When you first in-
stall an unrecognized card, you’ll hear
a warning beep. Run CardWizard and
allow it to configure the system re-
sources. The next time you install that
card, CardWizard will recognize it and
adjust the system automatically.

&)

Installing CardWizard

Winbows NT 4.0

The CardWizard utility is the same as that for
the Windows 95. You should install it after you
have activated the PC Card utility in Windows
NT. To install,

1l

Open Control Panel > Add/Remove Pro-
grams and choose Install...

Insert the Software & Utilities CD-ROM and
click Next> (button).

Browse to
D:\drivers\nt40\pcmcia\setup.exe*,
Click on Open then the Finish button.

* This assumes your CD-ROM is drive “D:".

Follow the program’s dialog boxes. The util-
ity creates a set of sub-directories for itself
in the Program Files directory on your C:
drive unless you choose otherwise.

Near the end of the installation, the utility asks
if you want to view the “readme” file. We
suggest you take a moment to scan it.

When the installation is complete, allow
the system to reboot to complete the setup.

Note: To activate the PC Card, open Control Panel
> Devices, and choose “Pcmcia” from the listings.
Click on Startup... then choose “System”. Click
on OK, then on Close. Reboot the system for the
changes to take effect.



PORT REPLICATOR (Oprionar)

The Port Replicator is designed to enable easy, and more perma-
nent peripheral connections with your notebook computer.

These connections, except where noted, exactly replace similar
connections on your notebook computer:

USB Port (2 ports)

¢

Serial Port (COMT1)

El}

TV-out Port (S-type).

VGA Port.

Parallel Port

O
L
B

PS/2 Port for a compatible pointing device.

PS/2 Port for a PS/2 compatible keyboard.

S Power Socket: Depending on your notebook model, this serves
as a pass-through connector to the notebook’s own DC-in port.
If your computer doesn’t support this feature, its function is null
- you must use the notebook’s DC-in port.

port replicator 6-9
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Port RepLICATOR DOCKING
Fic.6 -3 4.
5

6-10

DockING PROCEDURES

Make sure the system is OFF before connecting or discon-
necting the Port Replicator.

1.

. Turn on the computer.

Connect your peripherals to the Port Replicator. The connections are
marked with icons to help identify their functions.

. Make sure the Docking Lever is all the way back in its open position.

Make sure the expansion door on the rear of the notebook is open.

Position the notebook
between the slide con-
nection and ejector

gUides' DockiNG

Pull the docking lever Lever

forward to securely fas-
ten the Port Replicator.

UNDOCKING PROCEDURE

1.
2.

port replicator

Shut down your system or put it into Suspend mode.

Push the docking lever all the way back to the open position and lift
the notebook straight up, off of the Port Replicator.

Restart the notebook computer.



TROUBLESHOOTING

The monitor screen is blank or the video display dimensions are wrong.

solution: ¢ Make sure the monitor is turned ON and the notebook’s video
settings are set to recognize the attached monitor.

e Connect the monitor directly to the notebook’s VGA port to

make sure it's working. If it still doesn’t work, there may be a
problem with the monitor. If it does work when connected
directly, contact your service provider.

Other peripheral devices attached to the Port Replicator are not functioning.
solution: ¢ Make sure the cable connections between the Port Replicator
and the device(s) in question are undamaged and secured.
¢ Make sure the peripherals work when connected directly to
the notebook computer.
¢ Confirm the Setup settings for the ports.

¢ Shut down the entire system. Disconnect all peripherals from
the notebook. Disconnect all devices from their power sup-
plies. Reestablish all connections. Turn on any peripheral
with its own power supply. Lastly, turn on the computer.

REGULATORY INFORMATION

This device complies with Part 15 of the FCC Rules where op-
eration is subject to the following conditions: (1) This device may
not cause harmful interference; (2) this device must accept any
interference received, including interference that may cause un-
desired operation.

port replicator

6-11
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. Specifications

The information listed in this section is for reference only. It is subject to change at the
manufacturer’s discretion and without notice.

Unless otherwise indicated, none of the components and/or subsystems can be modified or ‘ A
upgraded.



[Specifications]

N1/

Warning

The CPU is not user-
upgradable. Do not try to
upgrade the CPU yourself
as doing so will violate the
warranty. Upgrading re-
quires additional system
adjustments. Any upgrade
procedure must be per-
formed by authorized ser-
vice personnel only.

A-2

CPU & chipset

CPU & CHIPSET

CPU

PGA (Socket 7) package:
Intel® Mobile Pentium™ series

Tillamook: (1.9V)233~266MHz(PPGA)
(2.0V)266~300MHZz(TCPtoSPGA)

AMD® series
K6-2T™: (2.2V)300~450MHz
K6-ST™: 2.2V)400~450MHz
Mobile K6-2T™: 1.8V)266~380MHz

Mobile K6-ST™:
Mobile K6-2P™:
Mobile K6-3P™:

CHIPSET
Core Logic: Aladdin-5
BIOS Phoenix (256KB Flash ROM,

(
(
(1.8V)333~400MHz
(2.2V)350~450MHz
(2.2V)350~450MHz

£

More on CPUSs
VOLTAGE, SPEED & POWER SAVINGS

upgradable to 512KB) sup-
ports MMX, PnP 1.0a, APM
1.2, ACPI, PCI 2.1, LBA
mode

Generally, higher voltage or faster CPUs use
more power and run “hotter”.

So of these options, a 233MHz “Tillamook”
Pentium™ running at 1.9V is the most energy
efficient, though among the slowest. However,
actual power consumption also depends on the
amount of “work” the CPU must perform.

PACKAGING

The “PGA” format features a removable CPU.
The accompanying chipset is hard-wired onto
the mainboard.

MMX
As of press-time, all CPU options include MMX™
technology.



MEMORY
L1 cache (in CPU):

Intel® Mobile Pentium™ 16KB code + 16KB data
Other (AMD® series) 32KB code + 32KB data
L2 cache:
Intel Mobile Pentium™/AMD®K6-2™ 512KB Pipeline Burst SRAM
AMD® K6-ST™ (on die) 256KB Pipeline Burst SRAM
L3 cache (user upgradable):
AMD® K6-ST™ 512KB Pipeline Burst SRAM
RAM *: up to 256MB maximum using one or both sockets

Socket 1 & Socket 2 requirements:
¢ 16MB, 32MB, 64MB, or 128MB modules
® 144-pin SO-DIMMs
* 3.3-volt
* TSOP package
¢ SDRAM DIMMs
— rated at 10ns or faster

“User upgradable.

memory
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AV

ViDEO
VGA Controller

Display Memory
Video Bandwidth

LCD options
Ports

AUDIO

Controller

Compatibility

Built-in

Ports

ATl Rage LT Pro
(with 3D, AGP & ZV
support/proprietary
driver)

4MB, 3.3V SGRAM
(upgradable to 8MB)
128bit
TFT:12.17/13.3”
CRT: 15pin VGA
TV-out (NTSC/PAL)

ESS Maestro 2E
(proprietary driver)

PnP, 64-voice dual-audio
engine, 20-bit ADC/DAC
audio resolution

Sound Blaster Pro™
legacy audio, 1°S/Zoomed
video, MS Windows
Sound System™

2 speakers, microphone,
0.5watt stereo amp.
Line-in, Mic-in, Head
phone/speakers-out

%

More on Video Standards

Depending on the OS, the AT/ Rage LT Pro Con-
troller supports these resolutions (in pixels).

eNTSC 640 x 400
*VGA 640 x 480
*SVGA 800 x 600

NTSC TV
all LCDs and monitors
LCDs, monitors & PALTVs

*XGA 1024 x 768 LCDs & monitors
¢SXGA 1280 x 1024 monitors

/Rc"'?rs. . ‘ VGA ‘ SVGA ‘ XGA ‘ SXGA
Single Display

256° v v v v

16 bit (HiColor) v v v v

24 bit (TrueColor) v v v v

32 bit (TrueColor) v v v

Dual Display (LCD+Monitor only)

256° v v v v
16 bit (HiColor) v v v v
24 bit (TrueColor) v v v

32 bit (TrueColor) v v

v resolutions available with 4MB of video RAM.




DRIVES

Factory-Installed Modules 24X or faster CD-ROM or 2X DVD-ROM

HDD Bay

FDD Drive

I/0

usSB

Parallel/Printer
Serial 1

Serial 2
TV-out

PS/2

PC Card
Expansion

2.5”,12.7mm (or lower) removable 2GB or larger
PCI local bus IDE Interface
3.5” 1.44MB FDD (3-mode option)

1channel on board

(+1 channel extended through port replicator)
max output /channel = 500mA

complies with PC98 spec. rev.1 sec.7.2
25-pin, bi-directional, SPP, EPP v1.9, ECP v1.7
9-pin, RS232C, NS16C550A compatible

IrDA v1.1 FIR, ASK

mini-din

mouse or keyboard

2x Type Il or 1x Type Il PC Card (with ZV support)
proprietary port replicator (120 pin)

drives & 1/O
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Recharge timing
To calculate how long it
will take your battery to
recharge, first check its
capacity (e.g. 4000mA)
then divide by the appro-
priate speed.

For example, a 4000mA
Ni-MH* battery should
take about 2 hours to
fully recharge with the
system off, and 10 hours
with the system running.
However, your time may
be faster since under
most conditions your
battery is rarely com-
pletely empty (there’s
usually a small “re-

serve” charge left).
*NiMH batteries charge at a
constant rate. Li-ion batter-
ies” charge rate slows for
about the last 25%.

A-6 power

P OWER (MINIMUM REQUIREMENTS)

Power input
19VDC, 55W/60W

AC Adapter output
19VDC, 2.8A

AC Adapter input
100~240VAC, full range, autosensing

Battery (form)
SL-36 (Ni-MH) or 202 (Li-lon)
“smart” or “dumb”

Battery Charging*
Fast (system off) 2000mA +200mA/hr
Slow (system on) 400mA = 50mA/hr
“Trickle” <100mA/hr

See the sidebar for an explanation of limitations.

Estimated Battery Life®
“max. battery life”: 2h 38m (NiMH)
3h 12m (Li-lon)
2h 2Tm (NiMH)
2h 50m (Li-lon)

“max. battery temperature”: 60°C

* These numbers are very rough guides for two
Setup default configurations.
See the sidebar for an explanation of limitations.

“disabled”:

£y

More on Charging
Your system doesn’t require a proprietary bat-
tery, so to accomodate the widest range of bat-
teries on the market, and still be safe, we’ve
taken a lot of factors into consideration:
Tyee

Different batteries accept charge at different
rates. If the system charges faster than the bat-
tery can accept, it may damage the battery.
ENVIRONMENT

Removeable batteries’ contacts can be contami-
nated (oils, smoke, etc.), inhibiting current flow.
TEMPERATURE

This is the most important safety consideration.
If the temperature gets too high, the system au-
tomatically slows the recharging process to re-
duce heat generation. Too much heat, and your
battery could explode!

ConpiTion

This is a huge catch-all, which includes the
amount of charge already present and how
worn your battery is. If the system senses the
battery is almost full, it slows the charging so it
doesn’t overload the battery.
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More on Battery Life

We can’t be more specific because performance
varies depending on many factors, including
battery condition, capacity, environmental con-
ditions, system usage habits, software require-
ments, and (not least), system configuration.
Our extremely artificial examples are based
on the following configuration:

Battery: NiMH (SL-36) 4000mA
Li-lon (ME202BB) 4500mA

CPU: AMD K6-2 300MHz (2.2V)

RAM: 32MB RAM

Video: 4MB Video SGRAM, 12.1 TFT LCD
Ports: All enabled, No USB devices attached
Software test package: ZD BatteryMark 2.0
ambient temperature: 25°C (77°F)

Your system’s performance and configuration
will be different, so it's possible for you to get
much better results.

OTHER FEATURES

TouchPad built-in PS/2 pointing
device by Alps Inc.
(with proprietary supple
mental drivers)

Kensington Lock standard security interface

ENVIRONMENT

Operating Temperature 0°C to 35°C
(32°F to 95°F)
Storage Temperature -10°C to 65°C
(14°F to 149°F)
20% to 80%
non-condensing
10% to 90%
non-condensing

Operating Humidity

Storage Humidity

DIMENSIONS

Hight 45mm  (1.777)
Width 310mm  (12.20”)
Depth 240mm  (9.45")
Weight 3.3KG (7.26lbs)

with Li-lon battery,
FDD, HDD & CD-ROM

environment/dimensions
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ACCESSORIES/OPTIONST

+12.1/13.3” TFT SVGA or XGA LCD module

*56Kbps v.90 Fax Modem module

+24x CD-ROM or 2X DVD-ROM

*3.5”, 1.44MB FDD

Drivers for hardware, system software, bundled applications
User’s manual

Expansion DRAM module(s): 1T6MB, 32MB, 64MB, or 128MB
TV terminal cable

AC adapter with power cord

Port replicator

Battery pack: SL-36 (Ni-MH) / 202 (Li-lon)

Car adapter (19VDC, 2.4A output)

Carrying Bag

Options may not be immediately available and/or may be standard
accesories depending on your package.
Optional Factory Installed Modules

A-8 accessories & options



.Troubleshooting

This section is about what you should do if something goes wrong with your system. This
can’t anticipate every possible problem, but you should check here before you panic. If you
don’t find the answer in these pages, make sure you have followed the instructions carefully
and observed the safety precautions in the preface. If all else fails, talk to your dealer. You
should also make a record of what happened and what remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, ( B
so you should preview this section just in case. If, after you've tried everything, and the
system still won’t cooperate, try turning it off for a few minutes and then rebooting. You will

lose any unsaved data, but it may start working again. Then call your dealer or service
representative.



Trouble

GETTING STARTED

This first group of problems and solutions may seem obvious but
you’d be surprised at how many “experienced” users have simi-
lar problems.

Power

You turned the power on but it doesn’t work.

possible cause: Battery missing/incorrectly installed

indicator: If the battery status icon, IIID, doesn’t appear, then

the battery may be missing or incorrectly installed.

solution: Check the power bay, make sure the battery is present
and seated properly (the design of the battery only
allows it to go in one way). Make sure there’s nothing
interfering with the battery contacts.

possible cause: Low battery
indicator: The battery status icon, I, is flashing.
solution: Plug in the AC power source. If the computer doesn’t

start up immediately, turn it off then on again.

possible cause: Fn+ & has been toggled or startup screen is set to CRT.
indicator: The various icons appear, but no picture.
solution: Toggle the Fn+ [E combination. Wait a few moments

before trying this control again.

B-2 power



With the system off, plug in (and turn on) a CRT to the
appropriate port. Reboot, enter Setup and reset the startup
display.

You are losing battery power too quickly.

possible cause:

indicator:
solution:

possible cause:

indicator:
solution:

possible cause:

indicator:
solution:

The system is using too much power.

The battery status icon, cycles too quickly.

Go into Setup (see Chapter 4: Firmware), and adjust
the controls available in the Power menu. If your op-
erating system has a power management scheme (i.e.
APM) check its settings. You may also be using a PC
Card device which is drawing a lot of power (e.g. a
Type 1lI storage device).

The battery does not fully charge due to prolonged inac-
tivity.

The battery life per charge is too short.

Refer to Chapter 5: Power, Use & Charge.

The battery is too hot.

The battery is warm to the touch.

Allow the battery to cool. If this problem persists, make
sure the vents aren’t blocked and the computer isn’t
sitting on a thermal surface.

Make sure you're using the correct adapter.

power



Trouble
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power

possible cause:
indicator:

solution:

The battery has a defect or has become defective.
The battery status icon’s 5 bars, are flashing.

Replace the battery. The rechargeable batteries avail-
able for this computer are manufactured to exact stan-
dards so the problem may be in your environment. Heavy
air pollution, moisture and other contaminants may make
battery leads corrode. If this is the case, don't take chances.
Refer to the safety precautions in the Preface.

The notebook feels too hot.

possible cause:
indicator:

solution:

The system is using too much power.
The computer feels uncomfortably warm.

Reduce the computer’s power consumption (refer to
Chapter 4: Firmware and Chapter 5: Power). Make sure
the notebook is properly ventilated and the fan port is
not blocked. If this doesn’t cool it down, put the system
into Suspend mode or turn it off for an hour.



DispLAY

Nothing appears on the screen.

possible cause:
indicator:

solution:

possible cause:
solution:

possible cause:
solution:

The system is in a power saving mode.
The Suspend icon, & s flashing.

Press a key on the keyboard. Toggle the suspend key com-
bination (see Chapter 1: Introduction, Hot Key Controls).

The screen controls need to be adjusted.

Toggle the screen control key combinations (see Chap-
ter 1: Introduction, Hot Key Controls).

The computer is set for a different display.

Toggle the screen display key combination (see Chap-
ter 1: Introduction, Hot Key Controls). If this works, the
next time you bootup you should go into Settings (but-
ton) on the Display Properties page and choose the
proper output device (see Chapter 2: System). If an
external monitor or TV is connected, turn it on.

The screen is flickering.

possible cause:

solution:

The vertical refresh rate is insufficient.

(1) Avoid using the Simultaneous display mode. Use
LCD only or CRT only.

(2) Switch to a lower resolution and/or fewer colors.

(3) Adjust the refresh frequency in the display controls

display



Trouble
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display

The screen images aren’t clear.

possible cause:

solution:

possible cause:

indicator:

solution:

possible cause:

indicator:

solution:

possible cause:

indicator:

solution:

The screen controls need to be adjusted.

Toggle the screen control key combinations (see Chap-
ter 1: Introduction, Hot Key Controls).

The viewing angle of the LCD is bad.

The screen appears shiny or too dim.

Adjust the position of the LCD. LCDs are designed to be
viewed “straight on”. If the angle is wrong, you may
see glare from the screen’s backlight.

The screen is dirty.

The screen images are blurry.

Clean the screen using a soft, clean dry cloth. Many
cleaning solutions can damage the LCD surface so you
should follow the precautions outlined in the Preface.
Try to avoid touching the screen itself. Even the cleanest
hands can leave oils which attract contaminants.

The screen is suffering from burn-in.

The screen has ghost images, even when it’s off.

This problem is usually associated with monitors. Use power
saving options (see Chapter 4: Firmware and Chapter 5:

Power to turn off the LCD. You can also use a screen-saver
which can help protect an attached monitor.



OPERATION

The system gives you garbage when you try to read a hard disk from an-

other computer.
possible cause:
indicator:
solution: (@)

The system freezes.
possible cause:

indicator:

solution:

possible cause:

The hard disk is not recognized.
The system cannot boot from the hard disk.

The BIOS usually automatically detects the parameters of
the hard disk. However, it may occasionally detect a dif-
ferent set of parameters. If the system cannot use the hard
disk, check the parameters of the hard disk in Setup. Use
the User option to manually adjust the parameters if they
are not the same as the original settings.

The Setup’s Auto type Primary Master assumes that any
hard disk 528 MB or larger is formatted using “LBA”
mode. Some older systems don’t use LBA mode. If your
hard disk wasn’t formatted using LBA mode, you must
enter Setup’s Primary Master Type section and manu-
ally adjust the LBA Mode Control switch to “Disabled”.
Since LBA mode is the preferred standard, you may
want to consider reformatting your hard disk.

The system’s power saving features have timed-out.
The Suspend icon, «#s, has no drops.

Use the AC adapter, press the Suspend key combina-
tion or press the Power On button if no icons are visible.

The system has “crashed” because of a software conflict.

operation
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operation

solution:

possible cause:
indicator:

solution:

Consult your operating system manual. As a last resort, since
you will lose any unsaved data, try to reboot the system or if
that doesn’t work, turn the computer off and on again.

The system cannot access the Save to Disk partition.

The system retrieves Save to Disk information very
quickly during bootup and then freezes.

This situation usually happens after one of the follow-
ing occurs and you activate the Save to Disk process:
(1) the hard disk has been changed; or (2) there has been
a CMOS failure or a Checksum failure and the problem
has not been corrected. If one of these occurs, you must
run the PhDisk utility as soon as possible. Refer to Set-
ting up for Save to Disk in Chapter 5: Power.

The Save-to-Disk function does not work.

possible cause:
indicator:

solution:

The system cannot access the Save to Disk partition.

When you press the Fn + 2 key combination, normal
Suspend is activated instead of Save to Disk.

(1) Check if you have selected Save to Disk in the Power
Savings menu in Setup. Refer to Chapter 4: Firmware.
(2) You may not have set up the Save to Disk partition.
Refer to Chapter 5: Power to setup the partition.

(3) You installed a different hard disk with a Save to Disk
partition on it or there has been a CMOS or Checksum
failure. You must run the PhDisk utility after one of the
above conditions.



The system never goes into Suspend mode.
possible cause: Power management features are not enabled.

solution: Go to the Setup’s Power Savings menu and enable the
features you prefer. Refer to the Power Management
section of Chapter 5: Power.

The system does not go into Suspend (ro RAM) or Save to Disk when the
battery is low.

possible cause: Suspend Timeout is disabled.

solution: Use one of the Power Management presets or manually
set the Suspend Timeout in the Power Savings menu in
Setup. Refer to Chapter 4: Firmware and Chapter 5: Power.

The PC Card does not work.

possible cause: The drivers are not loaded.
indicator: The system cannot access the card after it is installed.
solution: Load the proper drivers (see Chapter 2: System and Chap-

ter 6: Extras).

How do | get the CD-ROM'’s auto-run feature to work?

solution: In Windows 9x, go into the Control Panel > System >
Device Manager (tab) > CDROM, then double-click
the item listed. Click on the Settings (tab) and check
the box for “Auto insert notification”. Click on the OK
buttons to get out, then restart the system.

operation
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POST MESSAGES

Each time you boot up, the computer performs a self-diagnostic

M check.

Faster Repairs
Keep a record of any

warning messages; it ~ VWWARNING MESSAGES

may help to reduce re- If there is an error during the self-diagnosis, a short message will
pair time. display specifying the error. You can press F1 to try to continue
the boot process, or press F2 to run Setup.

If the following messages occur, press F2 to run Setup.

message:  Diskette drive A error
description: The floppy drive is present, but fails the BIOS POST.
solution: 1. Make sure the FDD is fully inserted into the Floppy bay or

attached to its external adapter and then to the parallel port
(refer to Chapter 3: Media)

2. Check that the FDD is correctly defined in Setup (refer to
Chapter 4: Firmware).

message:  Extended RAM failed at offset: nnn
B ' description: The extended memory is not working or not configured properly.
solution: 1. Make sure the expansion memory is seated properly in its

socket(s) (refer to Chapter 6: Extras).

2. Run Setup to allow the system to recheck the amount of
memory present, then save the Setup information and reboot
(refer to Chapter 4: Firmware).

B-10 post errors



message:

description:

solution:

message:

description:

solution:

message:

description:

solution:

Failing Bits: nnnn

The hex number, nnnn, is a map of the bits at the RAM address
that failed the memory test.

1. Make sure the expansion memory is seated properly in its
socket(s) (refer to Chapter 6: Extras).

2. Run Setup to allow the system to recheck the amount of
memory present, then save the Setup information and reboot
(refer to Chapter 4: Firmware).

3. Turn off the system and remove any DIMMs (refer to Chap-
ter 6: Extras). Restart the system. If the problem persists, con-
tact your service center. If the problem disappears, replace
the DIMMs one at a time to identify the defective module.
Replace any defective DIMMs.

Fixed Disk x Failure or Fixed Disk Controller Failure

The hard disk is not working or is not properly configured.

1. Check that the HDD is properly attached (refer to Chapter
3: Media).

2. Run Setup to make sure the HDD is correctly configured
(refer to Chapter 4: Firmware).

3. Make sure the HDD’s jumper settings are correct - “master”
for both (refer to Chapter 3:Media).

Incorrect Drive A: type - run Setup

The FDD is incorrectly identified in Setup.

Run Setup and check the settings for the FDD, usually 1.44MB/
3 '%2", (refer to Chapter 4: Firmware).

post errors
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message:
description:
solution:

message:
description:
solution:

message:
description:
solution:

Keyboard controller error

The keyboard controller failed the POST.

1. Try restarting the system.

2. If you are using an external keyboard, remove it and make
sure the onboard keyboard works correctly. If it does, you may
have to replace the external keyboard.

3. If you changed the video output, make sure you didn’t
dislodge the keyboard ribbon connectors (refer to Chapter 2:
System).

4. If the problem persists, contact your service center.

Keyboard error

The POST doesn’t see the keyboard.

1. Try restarting the system.

2. If you are using an external keyboard, remove it and make
sure the onboard keyboard works correctly. If it does, you may
have to replace the external keyboard.

3. If you changed the video output, make sure you didn’t dis-
lodge the keyboard ribbon connectors (refer to Chapter 2: Sys-
t e m )

4. If the problem persists, contact your service center.

Keyboard error nn

The BIOS discovered a stuck key and lists its scan code.

1. Press the keys on the keyboard to loosen the one with a
problem.

2. If keys consistently fail to spring up, contact your service
representative.



message:

description:

solution:

message:

description:

solution:

message:

description:

solution:

message:

description:

solution:

Monitor type does not match CMOS

The CMOS doesn’t recognize your monitor (LCD).

Run Setup then save and exit. The system will survey itself
then update its record (refer to Chapter 4: Firmware).

Operating system not found.

The operating system can’t be found on either drive A: or drive C:.
1. Assuming there is an operating system to be found, enter
Setup and make sure the FDD and/or Fixed Drive 1 are cor-
rectly identified (refer to Chapter 4: Firmware).

2. Make sure the HDD is properly installed.
3. If your HDD was set up with multiple partitions, make sure
drive C: is active (boot up from drive A: and use FDISK.EXE).

Parity check 1 nnnn or Parity check 2 nnnn

The BIOS found a parity error in the system bus.

1. Reboot.

2. If the problem persists, contact your service representative.

Press <F1> to resume, <F2> to Setup

The POST discovered a recoverable error.

1. Press F1 to continue and boot up, hoping the system will
function without further problem.

2. Press F2, enter Setup, correct the problem, save & exit.

post errors
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message:  Previous boot incomplete - Default configuration used
description: The last POST couldn’t be completed so the POST loaded the
defaults and gave you a chance to run Setup.

solution: Run Setup and make sure all the settings are correct.
message:  Real time clock error

description: The real-time clock failed the BIOS test.

solution: Contact your service representative. The onboard battery may

have to be replaced. or this may indicate a deeper problem.

message:  Shadow RAM failed at offset: nnnn
description: The shadow RAM in the 64K block failed at the “nnnn” address.
solution: 1. Reboot.

2. Contact your service representative.

message:  System battery is dead - Replace and run Setup
description: The CMOS clock battery indicator shows the battery is dead.
solution: Contact your service representative to replace the onboard

battery. Then run Setup to reestablish the correct settings.

message:  System cache error - Cache disabled
B ' description: The RAM cache failed the BIOS test and was disabled.
solution: 1. Reboot.

2. Continue without the cache, though system performance
will be degraded.
3. Contact your service representative.
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message:

description:

solution:

message:

description:

solution:

message:

description:

solution:

System CMOS checksum bad - run Setup

The system CMOS has been corrupted or modified incorrectly.
Run Setup and reconfigure the system.

Note: This may indicate the CMOS was targeted by a virus.
Reboot from an anti-virus program on a write-protected floppy.

System RAM failed at offset: nnnn

The system failed at the “nnnn” address.
1. Reboot.

2. Contact your service representative.

System timer error
The timer test failed.
Contact your service representative.

post errors
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OTHER MESSAGES

If your hard disk is disconnected after the POST but before the
operating system starts to initialize, you may get the following mes-
sage:

Hard disk failed
Press ‘H’ to retry Hard Disk, any other key for floppy

You can press H to try again or press any other key to boot from a
floppy. If you feel that the hard disk is improperly connected, turn
off the system before reinserting the hard disk.

B)
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. Glossary

A-B

Adapter
(1) A device that allows compatibility between different equipment.
(2) A printed circuit board that connects a system board to a peripheral I/O device

(devices) or adds specialized functions to the system.

Address
An identification, such as a label, number, or name that designates a particular location in
storage or any other data destination or source.

Application ‘ G
A program such as a word processor, image editor or database.
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G-2

as - cd

ASCII
An acronym for American Standard Code for Information In-
terchange. A 7-bit standard code adopted to facilitate the
interchange of data among various types of data processing
and data communications equipment.

Backlight
The rear illumination of an LCD screen.

BIOS
An acronym for Basic Input/Output System. The program
that customizes a computer.

Boot
Derives from “bootstrap”. To start or restart a computer sys-
tem by reading instructions from a storage device into the
computer’s memory. If the computer is already turned on,
it’s a “warm boot;” if not, it’s a “cold boot.”

C-D

Cache memory
A small high-speed memory for the temporary storage of informa-
tion, usually used between a slower large memory and a fast
central processing unit.

CD-ROM
Compact Disk Read Only Memory. This refers to both the
disk type and the drive. The disk can hold over 600 MB of



data, text, graphics, sound and video information. Although
the form is similar to the audio CD, its formatting is different.
CMOS
Complementary Metal-Oxide Semiconductor. This chip keeps
track of setup information. The BIOS is located on this chip.
The Setup utility is used to change it.
Configure
To assemble a selection of hardware or software into a sys-
tem and to adjust each of the parts so that they all work
together.
Configuration
An assembly of machines that are interconnected and are
programmed to operate as a system. The layout or design of
elements in a hardware or information processing system.
CPU
Central Processing Unit. The component of a computer sys-
tem with the circuitry to control the interpretation and ex-
ecution of instructions. This computer has a “Pentium”.
Crash
The system suddenly stops working. This usually requires a
system reboot.
Disk drive
A device that reads data from a magnetic disk and copies it
into the computer’s memory so that it can be used by the
computer, and that writes data from the computer’s memory
onto a disk so that it can be stored.

cm - di
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DOS
An acronym for Disk Operating System. A specialized, disk-
oriented program that provides an easy-to-use link between
the user and a computer’s disk drive.

DRAM
Dynamic RAM. Storage that the computer must refresh at frequent
intervals.

Driver
A series of instructions the computer follows to reformat
data for transfer to and from a particular peripheral device.
The electrical and mechanical requirements are different
from one kind of device to another, so software drivers are
used to standardize the format of data between them and
the central processor.

E-F
External option
An device attached to the outside of the system unit which
extends and enhances its operation. i.e. printer or mouse.
G-H
Hot
(i.e. a socket/port is hot.) A port is always ready to accept a
connection.
Hot Swap
Hot Swappable devices can safely be attached or removed
from the computer without turning it off. This procedure

G-4 do - ho



may also include special commands. The operating system,
PnP BIOS, hardware and power subsystems, are coordinated
to detect the device’s presence and status and stop the sys-
tem from “crashing” during a swap.

I-]

IDE
An abbreviation for Integrated Drive Electronics (or Intelli-
gent Device Electronics). Among IBM-compatible comput-
ers, this is the most common type of internally-mounted hard
disk controller. External devices usually use SCSI controllers.

Internal option
A part installed inside the system unit cover which enhances
operation of the system, such as an adapter and a memory
chip.

Interrupt
A signal that, when activated, causes the hardware to trans-
fer the program control to some specific location in main
storage, thus breaking the normal flow of the program being
executed.

K-L

KB
(Kilobyte) 1024 bytes.

LBA Mode
An abbreviation for Logical Block Address Mode. This is an
alternate way for the BIOS to interpret cylinder, head and

id—1b
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Ic - mo

sector information about hard disks. Before LBA mode, the
BIOS could not properly support IDE hard disks larger than
528 MB This system allows BIOS support for IDE hard disks
up to 8.4 GB.

LCD
An abbreviation for Liquid Crystal Display. A way to make
images appear by reflecting light on a special crystalline
substance. It features high visibility in high illumination lev-
els but no visibility in low illumination levels.

Load
In programming, enter data into storage or working regis-
ters.

M-N

MB
(Megabyte) 1,048,576 bytes, 1024KB

Memory
The storage facilities of the computer, capable of storing
vast amounts of data.

Microprocessor
The basic arithmetic, logic, and control elements required
for processing (generally contained on one integrated circuit
chip). Microprocessors are widely used as the control de-
vices for microcomputers, household appliances, and thou-
sands of other devices.

Mode
A method or condition of operation.



Monitor
A video display which comprises a CRT (Cathode Ray
Tube) and associated circuitry.

Mouse
A device for moving a cursor or other objects around on the
display screen. A typical mouse has one or more buttons on
the top of a small box that can be moved around on a flat
surface. The mouse’s main advantage is that it can move a
cursor around on the screen with great precision.

MPEG
Moving Picture Experts Group. A video and audio compres-
sion standard which allows decompression at 1.2 MB to 1.5
MB/second so CD players can replay color movies at a real-
istic 30 frames/second.

NTSC
National Television Standards Committee. A video broadcast
standard of 525 scan lines every 1/30 second. This is accom-
plished in 2 passes of 1/60 second each (60 Hz). This sys-
tem is used mostly in North America and East Asia.

Nonvolatile memory
The contents of the memory storage unit are not lost when
power is turned off (e.g. floppy, hard disk).

Notebook computer
A small portable computer that uses a flat panel liquid crys-
tal display. It is about the size of a large book.

L

mo — no
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pa — pc

O-P

PAL/SECAM
Phase Alternate Line and Sequential Color and Memory.
Two video broadcast standards of 625 scan lines every 1/25
second. This is accomplished in 2 passes of 1/50 second
each (50 Hz). These systems are used mostly in Europe,
Australia and parts of Africa.

Parallel printer
A printer that receives information from the computer one
character (letter, number, etc.) at a time through eight wires.
Additional wires are needed to exchange control signals.

Parameter
An arbitrary constant. A variable in an algebraic expression
that temporarily assumes the properties of a constant.

PC Card
This term has largely replaced the term PCMCIA. See PCMCIA.

PCI
Peripheral Component Interface. A 32/64-bit local bus ar-
chitecture widely used in Pentium-based PCs. Developed
by DEC, IBM, Intel, and others, a PCI bus provides a high-
bandwidth data channel between system-board components
such as the CPU and devices such as hard disks and video
adapters. The other widely adopted local-bus standard, the
VL-Bus, is primarily used in 486 PCs.



L

PCMCIA
Personal Computer Memory Card International Association.
A consortium of computer manufacturers that devised the
standard for the credit card-size adapter cards used in many
notebook computers. PCMCIA defines three card types: Type
I cards can be up to 3.3 mm thick and are generally used for
RAM and ROM expansion cards; Type II cards can be as
thick as 5.5 mm and typically house modems and fax mo-
dems; Type III cards are the largest (up to 10.5 mm thick)
and are mostly used for miniature hard disks. Windows 95’s
Plug and Play architecture provides PCMCIA support, which
automatically recognizes when PCMCIA devices are in-
serted and removed. The simpler term PC Card has largely
replaced this acronym to refer to these cards.
PnP

Plug and Play. The technology that makes Windows 95 au-
tomatically detect and configure most of the adapters and
peripherals connected to a PC. A fully PnP-enabled PC re-
quires three PnP components: a PnP BIOS, PnP adapters and
peripherals, and a PnP operating system. When adding a
PnP-compliant device to a PnP PC, the operating system, in
conjunction with PnP logic present in the BIOS and in the
device itself, handles the IRQ settings, I/O addresses, and
other technical aspects of the installation to ensure that the
device doesn’t conflict with other installed devices.

pc - pn G-9
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POST
Power-On-Self-Test. A sequence of self-tests automatically
run by the computer whenever it is turned on or is reset.

PPP
Point-to-Point Protocol. A protocol that allows a computer to
connect to the Internet through a dial-in connection and en-
joy most of the benefits of a direct connection, including the
ability to run graphical front ends such as Microsoft’s Internet
Explorer, Mosaic and Netscape’s Communicator. PPP is gen-
erally considered to be superior to SLIP, because it features
error detection, data compression, and other elements of
modern communications protocols that SLIP lacks.

Q-R

RAM
Random Access Memory. Memory into which the user can
enter information and instructions (write), and from which
the user can call up data (read). RAM is the “working
memory” of the computer, into which application programs
can be loaded from a storage device and then executed.

ROM
An acronym for Read-Only Memory. Generally, a solid state
storage chip that is programmed at the time of its manufac-
ture and that cannot be reprogrammed by the computer user.

G ’ Routine
A short set of program codes that perform a specific task.
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S-T
SCSI
An abbreviation for Small Computer System Interface. This
is a standard for connecting external devices (i.e. scanners and
storage devices) to computers.
Serial port
An input/output port in a computer through which data is
transmitted and received one bit at a time.
Setup
(D A utility program which modifies the BIOS.
(2) Assembly and adjustment of a computer’s components.
(3) The preparation of a computing system to perform a job
or job step. Setup is usually performed by an operator
and often involves performing routine functions.
(4) The preparation of the system for normal operation.
Stop clock
A mode in which the CPU effectively shuts down.
Stop grant
A mode in which the CPU stops processing instructions.
TCP/IP
Transmission Control Protocol/Internet Protocol. A set of com-
munication protocols developed by the U.S. Department of
Defense that allows dissimilar computers to share informa-
tion over a network. TCP/IP is the glue that binds the Internet.

sc — tc
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Uu-Vv

Utility
A program that helps the user run, enhance, create, or ana-
lyze other programs, programming languages, operating sys-
tems, and equipment. Utilities are designed to facilitate or
aid the operation and use of the computer for a number of
different applications and uses.

VGA
Video Graphics Adapter. Video system that allows simulta-
neous display of 256 colors at 640 x 480 graphics resolu-
tion and 720 x 400 text resolution.
This standard has been superceded by SVGA (256 colors at
800 x 600 resolution), XVGA (256 colors at 1024 x 768
resolution) and SXVGA (256 colors at 1280 x 1024 resolu-
tion)

Volatile memory
The contents of the memory storage unit are lost when the
machine is turned off (e.g. cache or RAM).

W-Z

Zoomed Video (ZV) Port
The ZV Port is an enhanced PC Card port which has a direct
connection between the PC Card and the notebook’s AV

subsystems. It allows for a dedicated data path to handle
G ' multimedia features.

G-12 ut — zo
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